
Racing Overview
When you're ready to get behind the wheel of your 
monster truck, you have several choices. You can:
· Race head-to-head against some of the toughest, 

meanest, fastest trucks on the professional monster 
truck tour. For details, see Starting a New Race.

· Test your mettle against other upstart racers who are 
eager to splash around in cyber-mud. For details, see 
Multiplayer Racing Overview.

Whichever way you choose to race, don't forget to keep 
your hands on the wheel and your pedal to the metal!
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Starting a New Race
To start a new race
1 On the Monster Truck Madness opening screen, in the

Driver's Name box, type or select a name.

2 In the Skill Level list, click the skill level you want. For
details on skill levels, see Setting Driver Skill Levels.

3 Click the button that looks like this 

.
Monster Truck Madness displays the Races screen.

4 In the Pick A Truck list, click the truck you want to 
drive.

5 Click the type of race you want to run.

Monster Truck Madness displays the appropriate race 
screen with several opponents already added to the 
Competing Trucks list.

6 To add a truck to the Competing Trucks list, click it in 
the    Available Trucks list, and then click Add.

–Or–

To delete a truck from the Competing Trucks list, click
it, and then click Remove.

Repeat steps 6 and 7 until all the trucks you want to 
race are in the Competing Trucks list.

7 Click the name of the track or tournament you want.

8 If you are racing a circuit, specify the number of laps.

9 When you're ready to put the pedal to the metal, click 
the button that looks like this 

.
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Pausing and Resuming a Race
At any time during a race, you can pause the action, save 
the race in the exact state and location at which you 
paused, and then resume the race whenever you're ready.

To pause and then resume a race
1 Press P.

Monster Truck Madness displays the Paused screen.

2 To resume the race, click Resume.
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Saving a Race for Later Play
If you need to quit Monster Truck Madness before you're 
finished with a race, you can save the race so that you can 
return to it whenever you want; in a day, a month, or even a 
year. You can also share saved races with other Monster 
Truck Madness players.

To save a race for later play
1 On the Race menu, click Save Race.

2 In the File Name box, type a name for the race.

3 Click Save.

To restart a race you previously saved
1 On the Race menu, click Resume Saved Race.

2 Click the race file that you want to open.

3 Click Open.

4 Click Resume.
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Quitting a Race
When you've had enough of the action, you can quit a race 
before you hit the finish line. You can pretend that the 
race was all a bad dream, or, if you prefer, you can save the
race to face the challenge at another time.

To quit a race before it's finished
1 On the Race menu, click End Race.

–Or–

Press ESC.

2 Click Yes.
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Quitting Monster Truck Madness
When it's time to park your truck and stop the madness, 
it's easy to quit Monster Truck Madness. Keep in mind that 
before quitting, you can save the current race and return 
to the action whenever you're ready.

To quit Monster Truck Madness
On the Race menu, click Exit.
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Removing Monster Truck Madness from 
Your Computer
If you ever need to remove Monster Truck Madness from 
your computer, you can use the Microsoft Windows® 95 
Add/Remove Programs wizard.

To remove Monster Truck Madness from your computer
1 Close Monster Manual, and quit Monster Truck 

Madness.

2 Click the Start menu, point to Settings, and then click 
Control Panel.

3 Double-click Add/Remove Programs.

4 In the software list, click Microsoft Monster Truck 
Madness.

5 Click Add/Remove.

The Monster Truck Madness Setup dialog box is 
displayed.

6 Click Remove All.

7 Click Yes.

8 When the uninstall is complete, restart Windows 95.
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Universal Keyboard Game Controls
These universal controls are available no matter what type 
of driving control you use—joystick, gamepad, whatever. 
Print this topic and use it as a handy reference.

For information on how to drive your truck with your 
preferred driving controls, see Driving with the Keyboard, 
Driving with a Joystick, Driving with a Gamepad, or Driving 
with Race Car Controls.

In cockpit view, to look… On the numeric keypad, 
press and hold down…

To your left INSERT

To your right DELETE

Behind you PLUS SIGN (+)

To… On the keyboard, press…
Call the helicopter H

Display or hide MINUS SIGN (-) on the
the rear view mirror numeric keypad

Display or hide the F
directional finder

Display or hide the TAB once
overlay map

Display truck and position TAB twice
labels on overlay map

Hide truck and position TAB three times
labels on overlay map

Display or hide truck and N
driver labels in any view

Display or hide the O
pit board

Display or hide the D
dashboard

Stage automatically S

Honk your horn SPACEBAR

Mute sounds CTRL+M

Switch between full-screen F4
and windowed modes



To switch views… On the keyboard, press…
Between views V
of current truck

To another truck K

To your truck's CTRL+1
cockpit view

To point the camera
in an external view… Press…
Left INSERT on the numeric keypad

Right DELETE on the numeric keypad

Up PLUS SIGN (+) on the numeric
keypad

Down MINUS SIGN (-) on the 
numeric keypad
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Calling the Rescue Helicopter
When you have one of those "I've-fallen-and-I-can't-get-
up" kind of racing days or you've strayed too far from the 
course and need help finding your way back, you can count 
on the helicopter to come to your rescue. When you call it, 
the helicopter hooks onto your truck, rights it, and then 
drops you back on the track.

To call the helicopter for emergency assistance
Once you're lost or stuck, press H to call the 

helicopter.
The helicopter hooks onto your truck, rights it, and 
then drops you back on the track.
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Driving Controls Overview
You can control your monster truck using a keyboard, 
joystick, gamepad, or racing car controls. 

Depending on whether you drive with an automatic or a 
manual transmission, the driving controls are slightly 
different.

For details on using those controls, see Driving with the 
Keyboard, Driving with a Joystick, Driving with a Gamepad, 
or Driving with Race Car Controls.

For details on how to designate a joystick, a gamepad, or 
race car controls as your driving control, see Choosing a 
Primary Driving Control.

If you don't like the default driving control settings for 
keyboard, gamepad, or race car controls, you can customize 
them to suit your preferences. For more information, click 
Related Topics below.
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Choosing a Primary Driving Control
When you install Monster Truck Madness, it is assumed 
that you want to drive by using the keyboard, but you can 
specify a different driving control at any time.

To specify a primary driving control
1 On the Options menu, click Controls.

2 In the Primary Driving Control list, click the driving 
control you want (and the one for which you own the 
hardware!).

3 Click OK.

{button ,AL(`steersensitive;shifting;allkey;calibrate;custom
key;customjoy')} Related Topics



Driving with the Keyboard
Depending on whether you drive with an automatic or 
manual transmission, the keyboard controls are slightly 
different.

To choose either automatic or manual transmission
1 On the Options menu, click Game.

2 To drive with automatic transmission, under Driving 
Assistance, select the Auto Shift check box.

–Or–

To drive with manual transmission, clear the Auto 
Shift check box.

3 Click OK.

Keyboard Driving Controls
(Automatic Transmission)
Accelerate Hold down the UP ARROW key

Brake Hold down the DOWN ARROW key

Reverse gear* Hold down the DOWN ARROW key: 
Once the truck has made a complete 
stop, it shifts into reverse (check the 
PRNDL gear indicator to confirm 
you're in reverse).

Turn right Hold down the
RIGHT ARROW key

Turn left Hold down the
LEFT ARROW key

Keyboard Driving Controls
(Manual transmission)
Accelerate Hold down the UP ARROW key

Brake Hold down the DOWN ARROW key

Up Shift Press A

Down Shift Press Z

Reverse gear* Press A or Z until reverse is engaged 
(check the PRNDL gear indicator to 
confirm you're in reverse), and then 
hold down the UP ARROW key to 
accelerate in reverse.

Turn right Hold down the
RIGHT ARROW key

Turn left Hold down the
LEFT ARROW key

*    One note about reverse gear that you want to be aware 
of: If you have Auto Brake & Throttle enabled, you will not
be able to put your truck in reverse. If you get into a 
situation that you can't get out of, press H to call the 



helicopter. It will put you back on track. For information on 
how to turn off Auto Brake & Throttle, see Driving 
Cheats.

{button ,AL(`steersensitive;shifting;customkey;allkey')} 
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Driving with a Joystick
Depending on whether you drive with an automatic or 
manual transmission, or if you are using your joystick's 
throttle control, the joystick controls are slightly 
different. See Customizing Your Joystick Controls for 
information on assigning the acceleration function to your 
joystick's throttle control.

To choose either automatic or manual transmission
1 On the Options menu, click Game.

2 To drive with automatic transmission, under Driving 
Assistance, select the Auto Shift check box.

–Or–

To drive with manual transmission, clear the Auto 
Shift check box.

3 Click OK.

Joystick Driving Controls
(Automatic Transmission)
Accelerate Push forward

Brake Pull back

Reverse gear* Pull back. Once your truck has come to
a complete stop, reverse is 
automatically engaged.

Turn right Push right

Turn left Push left

Joystick Driving Controls with Joystick Throttle Enabled
(Automatic Transmission)
Accelerate Push throttle forward

Brake Pull throttle back

Reverse gear* Pull back on throttle. Once your truck 
has come to a complete stop, reverse 
is automatically engaged.

Turn right Push joystick to the right



Turn left Push joystick to the left

NOTE: You will not be able to assign the acceleration 
function to your joystick's throttle control, if you are 
running Microsoft Windows® NT operating system.

Joystick Driving Controls
(Manual Transmission)
Accelerate Push forward

Brake Pull back

Up Shift Press Button 1

Down Shift Press Button 2

Reverse gear* Press Button 1 or 2 until reverse is 
engaged (check the PRNDL gear 
indicator to confirm you're in 
reverse), and then push the joystick 
forward to accelerate in reverse.

Turn right Push right

Turn left Push left

Joystick Driving Controls with joystick throttle enabled
(Manual Transmission)
Accelerate Push the throttle forward

Brake Pull the throttle back

Up Shift Press Button 1

Down Shift Press Button 2

Reverse gear* Press Button 1 or 2 until reverse is 
engaged (check the PRNDL gear 
indicator to confirm you're in 
reverse), and then push the throttle 
forward to accelerate in reverse.

Turn right Push the joystick right

Turn left Push the joystick left

*    One note about reverse gear that you want to be aware 
of: If you have Auto Brake & Throttle enabled, you will not
be able to put your truck in reverse. If you get into a 
situation that you can't get out of, press H to call the 
helicopter. It will put you back on track. For information on 
how to turn off Auto Brake & Throttle, see Driving 
Cheats.
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Microsoft SideWinder 3D Pro Joystick 
Button Assignments
If you're using a Microsoft® SideWinder™ 3D Pro joystick
for racing with Monster Truck Madness, you can use the 
buttons on your joystick to access many great game 
controls.

The default button assignments for the SideWinder 3D Pro
are listed in the following table. You can also customize the 
joystick button controls to your preference at any time. 
For details, see Customizing Your Joystick Controls. For 
details on driving with a SideWinder 3D Pro joystick, see 
Driving with a Joystick.

SideWinder 3D Pro Joystick Default Button Assignments
Up shift Button 1 (trigger)
(manual transmission only)

Down shift Button 2
(manual transmission only)

Honk the horn Button 3

"Yeehaw!" Button 4

Display the pitboard Button 5

Switch camera view Button 6
between competing trucks

Call the helicopter Button 7

Switch between views Button 8
for the current truck



Looking Around in Cockpit View
When you are driving in cockpit view, you can use the 
SideWinder hat switch to look in different directions, or to
display the rear view mirror. 
To look… On the joystick,
Left Move the hat switch left

Right Move the hat switch right

Behind Move the hat switch down

To display or hide the rear view mirror
1 If you are not sure you are in cockpit view, press 

CTRL+1.

2 To display or hide the rear view mirror, move the hat 
switch up.

Changing Camera Positions in External Views
When you are driving in any external view, you can use the 
SideWinder hat switch to move the camera in any external 
view.
To point the camera… On the joystick…
Left Move the hat switch left

Right Move the hat switch right

Up Move the hat switch up

Down Move the hat switch down

{button ,AL(`shifting;customjoy;allkey;calibrate;steersensi
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Driving with Race Car Controls
If you're lucky enough to own a set of ThrustMaster 
Formula T1 or T2 or other race car controllers, you can 
really put yourself behind the steering wheel and literally 
put the pedal to the metal. (Check your controller. You may 
need to get drastic with the plastic!)

Depending on whether you drive with an automatic or a 
manual transmission, the race car controls are slightly 
different.

To choose either automatic or manual transmission
1 On the Options menu, click Game.

2 To drive with automatic transmission, under Driving 
Assistance, select the Auto Shift check box.

–Or–

To drive with manual transmission, clear the Auto 
Shift check box.

3 Click OK.

Formula T1 and T2 Driving Controls
(Automatic Transmission)
Accelerate Depress and hold down gas pedal

Brake Push and hold down brake pedal

Reverse gear* Push and hold down the brake pedal: 
Once the truck has made a complete 
stop, it shifts into reverse.

Dash button 3 Press to honk the horn

Dash button 4 Press to yell "Yeehaw!"

Formula T1 and T2 Driving Controls
(Manual Transmission)
Accelerate Depress and hold down gas pedal

Brake Push and hold down brake pedal

Up Shift Move the gear shifter up

Down Shift Move the gear shifter down

Reverse gear* Move the gear shifter up until reverse
is engaged, and then accelerate in 
reverse using the gas pedal.

*    One note about reverse gear that you want to be aware 
of: If you have Auto Brake & Throttle enabled, you will 
not be able to put your truck in reverse. If you get into a 
situation that you can't get out of, press H to call the 



helicopter. It will put you back on track. For information on
how to turn off Auto Brake & Throttle, see Driving 
Cheats.
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Driving with a Gamepad
Depending on whether you drive with an automatic or 
manual transmission, the gamepad controls are slightly 
different.

To choose either automatic or manual transmission
1 On the Options menu, click Game.

2 To drive with automatic transmission, under Driving 
Assistance, select the Auto Shift check box.

–Or–

To drive with manual transmission, clear the Auto 
Shift check box.

3 Click OK.

Gamepad Driving Controls
(Automatic Transmission)
Accelerate Push forward

Brake Push back

Reverse gear* Push back: Once the truck has made a 
complete stop, it shifts into reverse.

Turn right Push right

Turn left Push left

Gamepad Driving Controls
(Manual Transmission)
Accelerate Push forward

Brake Push back

Up Shift Press Button 1

Down Shift Press Button 2

Reverse gear* Press Button 1 or 2 until reverse is 
engaged, and then push forward to 
accelerate in reverse.

Turn right Push right

Turn left Push left

*    One note about reverse gear that you want to be aware 
of: If you have Auto Brake & Throttle enabled, you will 
not be able to put your truck in reverse. If you get into a 
situation that you can't get out of, press H to call the 
helicopter. It will put you back on track. For information on
how to turn off Auto Brake & Throttle, see Driving 
Cheats.

{button ,AL(`steersensitive;shifting;customjoy;allkey;calibr
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Game Controls
For information on driving controls, click a topic.

        Driving with the Keyboard  
        Driving with a Joystick  
        Driving with a Gamepad  
        Driving with Race Car Controls  
        Universal Keyboard Game Controls  



Customizing Your Keyboard Controls
Customize your keyboard settings to your preference at 
any time. Or, revert to the original keyboard settings at 
any time.

To customize keyboard settings
1 On the Options menu, click Controls.

2 In the Primary Driving Control list, click Keyboard.

3 Click Customize Keyboard.

4 Under Keyboard Settings, click the item that you want
to change.

5 Click Change.

6 Click the arrow to display the complete list of keys you 
can assign to the game function, and then click the one 
you want.

7 Click OK.

8 Click OK.

9 Click OK.

To revert to the original keyboard control settings
1 On the Options menu, click Controls.

2 Click Customize Keyboard.

3 Click Default.

Monster Truck Madness displays a message asking you 
to confirm that you want to return to the default 
settings.

4 Click OK.

5 Click OK.

6 Click OK.
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Customizing Your Joystick Controls
Customize your joystick settings to your preference at any 
time. Or, revert to the original joystick control settings at 
any time.

To customize joystick settings
1 On the Options menu, click Controls.

2 In the Primary Driving Control list, click Joystick.

3 Click Customize Joystick.

4 If you have a joystick with a throttle control, and wish 
to assign the acceleration function to that throttle 
control, click Use Joystick Throttle Control.

NOTE: You will not be able to assign the acceleration 
function to your joystick's throttle control, if you are 
running Microsoft Windows® NT operating system.

5 Under Joystick Settings, click the item that you want 
to change.

6 Click Change.

The button you are changing appears on the left side 
of the list box.

7 Click the arrow to display the complete list of game 
functions you can assign to the joystick control that is 
listed on the left, and then click the one you want.

8 Click OK.

9 Click OK.

10 Click OK.

To revert to the original joystick settings
1 On the Options menu, click Controls.

2 In the Primary Driving Control list, click Joystick.

3 Click Customize Joystick.

4 Click Default.

Monster Truck Madness displays a message asking you 
to confirm that you want to return to the default 
settings.

5 Click OK.

6 Click OK.

7 Click OK.
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Calibrating Your Joystick, Gamepad, or 
Race Car Controls
You can calibrate, or tune your joystick, gamepad, or race 
car controls precisely, without leaving Monster Truck 
Madness.

IMPORTANT: If you have not yet installed your joystick, 
gamepad, or race car controls, run the Add New Hardware 
wizard. To start the wizard, click the Start menu, point to 
Settings, and then click Control Panel. Double-click Add 
New Hardware, and follow the instructions on the screen.

To calibrate your joystick or gamepad
1 On the Options menu, click Controls.

2 In the Primary Driving Control list, click Joystick, 
Gamepad, or the race car control you use.

3 Click Calibrate.

4 If you have more than one joystick, click the one you 
want to drive with in the Current Joystick list.

5 In the Joystick Selection list, click the type of 
joystick or gamepad you are using. If your joystick or 
gamepad is not listed, click Custom.

6 Click Calibrate, and the follow the instructions on your 
screen.

7 To accept the recalibration and close the Joystick 
Properties dialog box, click OK.

To calibrate your T1/T2 race car controls
IMPORTANT: When connecting ThrustMaster T1/T2 race 
car controls for use with a Windows 95 game product, it is 
highly recommended that you use the Axis Converter that 
came with your race car controls. If you don't use the Axis
Converter, you may experience difficulty calibrating your 
race car controls. If you do not have an Axis Converter, it 
is recommended that you contact the ThrustMaster 
Service and Repair Department. In the U.S., call (503) 639-
3200 for a free converter.

IMPORTANT: Print this topic before starting the 
procedure. As you follow the steps below, a dialog box 
appears which may obscure this topic. Refer to the printed 
topic to finish the procedure.

To calibrate your T1/T2 race car controls

1 Click  to display the Joystick Properties dialog box.



2 In the Joystick Selection list, click Custom.
3 Under Axes, click 2 Axes.
4 Under Buttons, click 2 Buttons.

IMPORTANT: Do Not click Special Features or the Is
A Race Car Controller option.

5 Click OK.

6 Click Calibrate.

7 To accept the recalibration and close the Joystick 
Properties dialog box, click OK.

8 To return focus to the game, press ALT+TAB.

9 On the Monster Truck Madness Options menu, click 
Controls.

10 In the Primary Driving Control list, click Race Car 
Controller.

11 Click Calibrate.

12 Follow the instructions on the screen.

13 To accept the recalibration and close the Control 
Options dialog box, click OK.

{button ,AL(`driving controls;customjoy;Sidewinder')} 
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Looking Around from Within the Cab
While you're in the cab of your monster truck, you can 
always turn and look out your windows to keep track of the 
action all around you. When you watch the action from the 
cab, you are using cockpit view.

Use the shortcuts below to look all around you as you're 
driving in cockpit view. Your view automatically returns to 
the forward-looking position once you've let go of the key 
or joystick switch.

To look… On the keyboard, press and hold 
down…

To your left INSERT

To your right DELETE

Behind you PLUS SIGN (+) on the numeric 
keypad

To look… On the joystick,
To your left Move the hat switch left

To your right Move the hat switch right

Behind you Move the hat switch down

To display or hide the rear view mirror
1 If you are not sure you are in cockpit view, press 

CTRL+1.

2 Press the MINUS SIGN (-) on the numeric keypad to 
display or hide the rear view mirror.

–Or–

On the joystick, move the hat switch up to display or 
hide the rear view mirror.

{button ,AL(`views;display')} Related Topics



External Racing Views Described
Cockpit view isn't the only way to see a race. Keep track of 
the trucks and all the action by using several external 
racing views. Once you switch to an external view, pan the 
camera to look at the action from every possible angle.

It's easy to cycle quickly through the external views to 
find the perspective you want. You can even switch to a 
competing truck and cycle through the external views from 
that truck's point of view.

The external views are described in the paragraphs that 
follow. There are additional useful external views in drag 
racing. For more information, see Viewing Drag Races as a 
Spectator.

Chase near view and chase far view. Both chase views 
give you an elevated view of your truck as it races. Chase 
near view (press CTRL+2) offers a closer-in perspective. 
Chase far view (press CTRL+3) places you farther back. 
Use these views to keep tabs on opponents who are nearby.

Goodyear blimp view. This view (press CTRL+8) places you 
above your truck. Use this strategic view to check out your 
race position and to keep track of opponents in the general 
area. This is a great view to use when learning how to stage 
your truck in a drag race.

Automatic race camera view. You never know what you 
might find when you choose this view (press CTRL+4)! 
Automatic race camera view captures the hottest racing 
action from those great camera angles you know and love 
from televised motorsport racing.

{button ,AL(`looking;views;viewing')} Related Topics



Switching Between External Views
Monster Truck Madness has several cockpit and external 
views you can use to make sure that you never miss any of 
the awesome action on the road.

External views allow you to get inside (or outside and 
above) the competition for a really different perspective 
on the race action. 

To switch among views while driving
While you are driving, press V until the view you 

want is displayed.
–Or–

On the View menu, click the view you want.

To change the camera position in any external view
NOTE: You cannot change the camera position when you 
are in automatic race camera view or in any of the drag 
race external spectator views.

To point the camera… On the numeric keypad, 
press…

To the left INSERT

To the right DELETE

Up PLUS SIGN (+)

Down MINUS SIGN (-)

To point the camera… On the joystick…
To the left Move the hat switch left

To the right Move the hat switch right

Up Move the hat switch up

Down Move the hat switch down

To switch to a competing truck's point of view
1 While you are driving, press K to switch among the 

trucks in the race.

2 Next, press V to switch among cockpit and external 
views.

Move the camera position if you like (see the preceding
tables for details).

To return to cockpit view in your own truck
Press CTRL+1.

{button ,AL(`looking;views;viewing')} Related Topics



Viewing Truck Positions in Rallies and 
Circuits
Whenever you're driving in a rally or circuit race, you can 
display a miniature map of the course. Moving dots and 
position indicators represent all competitors and their 
positions on the track. The flashing yellow dot represents 
your truck's location. Your truck's current position is 
indicated in red within parentheses. 

If you need more details, you can also choose to display 
truck name labels on the map overlay. The labels include the
current race position of each truck in parentheses.

To Press
Display the overlay map TAB once

Display truck name labels TAB twice

Hide the overlay map TAB a third time

{button ,AL(`displaying;views')} Related Topics



Displaying Dashboard Instruments and the
Steering Wheel
When you're driving in cockpit view, you can display the 
major dashboard instruments, including the tachometer, 
speedometer, and the steering wheel, or you can remove 
them from view. The dashboard is displayed by default 
when you start a race, but you can hide it at any time.

In all external views, you can display a speedometer and 
tachometer overlay, if you wish.

Tips
· When you're driving by using the keyboard, you may 

find it handy to display the steering wheel, because it 
gives you visual feedback on the direction your truck is 
turning.

· In cockpit view or any external view, the tachometer 
and speedometer are especially useful if you're driving 
a truck that has manual shifting, because they provide 
feedback on when to shift.

To display or hide dashboard instruments and the 
steering wheel in cockpit view
1 If you are not sure you are in cockpit view, press 

CTRL+1.

2 To display or hide the dashboard instruments and the 
steering wheel, press D.

To display or hide the speedometer and tachometer 
overlay in any external view

To display or hide the overlay, press D.

{button ,AL(`views;looking')} Related Topics



Displaying the Rear View Mirror
While you are in cockpit view, you can display the rear view 
mirror to get a quick glimpse of the action behind you. The 
rear view mirror is available only in cockpit view.

To display or hide the rear view mirror
1 If you are not sure you are in cockpit view, press 

CTRL+1.

2 Press the MINUS SIGN (-) on the numeric keypad to 
display or hide the rear view mirror.

–Or–

On the joystick, move the hat switch up to display or 
hide the rear view mirror.

{button ,AL(`looking')} Related Topic



Viewing Drag Races as a Spectator
You can use a variety of views to watch drag racing heats in
which your truck is not racing. You can also access these 
views when you are racing, but you may find it's difficult to
drive your truck while you're sitting in the stands!

· Spectator stands starting line view. This view (press 
CTRL+5) gives you a perfect side-angle view of the 
starting line so that you can watch competing trucks as 
they come out of the blocks. You're in the perfect 
position to call the early lead.

· Spectator stands finish line view. This view (press 
CTRL+6) moves you a few seats down the track from 
the starting line. This spot gives you an awesome side-
angle view of the finish line. With this view, you'll be 
able to call the winner.

· Finish line on-track view. This view (press CTRL+7) 
takes you out of the stands and puts you where the 
action is: On the track and at the finish line! Get up-
close-and-personal with a monster truck that's gunning 
it straight at you going 70 miles per hour!

To switch between spectator views of a drag race
Press V until the view you want is displayed.

–Or–

On the View menu, click the view you want.

To skip viewing a drag race heat in which you're not 
racing

On the Draw screen, click Skip.

{button ,AL(`looking;views')} Related Topics



Displaying Truck and Driver Name Labels
You can keep track of who is driving the trucks in the pack 
ahead or behind you by displaying truck and driver name 
labels. As long as the trucks are in view, you'll see the 
labels.

To display or hide truck and driver name labels
To display or hide the labels, press N.

Tip: If the trucks are out of view in a rally or circuit race, 
you may prefer to display them on an overlay map. For more
information, see Viewing Truck Positions in Rallies and 
Circuits.

{button ,AL(`views')} Related Topics



Setting Driver Skill Levels
If you're a greenhorn whose staging foot gets a little too 
itchy, or if you're intimidated by the aggressive 
competition when the pack heads into a curve, you can 
choose a skill level that will make your driving experience 
less monstrously stressful.

Skill levels aren't for beginners only, of course. If you're 
cocky and confident and want to see how you would measure
up against the most aggressive drivers on the professional 
monster truck circuit, you may want to skip rookie and 
intermediate and go straight to professional.

Monster Truck Madness provides three skill levels to 
choose from:

· Rookie. When you drive as a rookie, the other trucks, 
if they're not downright hospitable, are less aggressive
and a lot more likely to make mistakes. In a drag, you 
have the benefit of staging help as you approach the 
drag race starting line. In all races, you also get the 
benefit of Auto Brake, which allows you to floor it 
before the light goes green. Auto Brake also slows 
your truck automatically to help you through nasty 
curves in circuit and rally races.

· Intermediate. When you choose intermediate level, 
don't count on anybody saying "Excuse me" as they 
come in close to grab the inside edge. You won't get 
help with staging, either. When you're driving 
intermediate, your truck has a higher top speed and 
more realistic monster truck handling characteristics, 
with challenging understeer and spin-inducing torque.

· Professional. Choosing this skill level is either a sign 
of high confidence and high skill or a horrible mistake. 
One trip around the track should tell you which it is. 
Your truck has an even higher top speed and more 
realistic monster truck handling characteristics than 
the rookie or intermediate skill levels. The other 
drivers are extremely aggressive; they take no 
prisoners and they rarely make mistakes. Good luck!

To assign a driver skill level
1 On the Monster Truck Madness opening screen, in the 

Driver's Name box, type or select a name.

2 In the Skill Level list, click the skill level you want.

3 To set up the race, click Races.

For help setting up the race, see steps 4 through 10 in 



Starting a New Race.

{button ,AL(`starting;prerace')} Related Topics



Automatic or Manual Transmission: 
Shifting Options
You can choose between automatic and manual transmission 
for your monster truck.

Driving with automatic transmission allows you to 
concentrate on the fun stuff: Steering, braking, 
accelerating, and bashing into your buddies. With automatic
transmission, the gear shift indicator automatically pops up 
to show you when the truck is changing gears, and you can 
hear the sound of the engine as it shifts.

Driving with manual transmission requires skill and 
concentration. In cockpit view, you need to keep an eye on 
the tachometer and the shift indicator light, which let you 
know when your engine is on the verge of revving beyond 
6500 rpms. If your engine passes 6500 rpms, you should 
shift into a higher gear.

In all external race views, you must use the tachometer to 
monitor your rpms, as the shift indicator light is only 
available in cockpit view.

To specify automatic or manual transmission
1 On the Options menu, click Game.

2 For automatic transmission, under Driving Assistance, 
click Auto Shift.

–Or–

For manual transmission, under Driving Assistance, 
clear Auto Shift.

3 Click OK.

{button ,AL(`driving controls;displaying 
dashboard;Sidewinder')} Related Topics



Tweaking Your Truck in the Garage
You can make adjustments and refinements to your truck's 
tires, suspension, and transfer gear ratios to optimize your 
truck's performance in a variety of racing situations.

Tire cuts offer different advantages in terms of rolling 
resistance and traction.

Suspension affects your truck's performance on curves and
when jumping or crossing ditches in a different way.

Transfer gear ratios affect whether your truck can gain 
speed faster with a slower top speed, or has a greater top 
speed with less acceleration capability.

To change your truck's tires, suspension, or transfer 
gear ratios
IMPORTANT: If you are racing, press ESC and quit the 
race. Then proceed to step 4 in this procedure.

1 On the Monster Truck Madness opening screen, click 
Races.

Monster Truck Madness displays the Races screen.

2 In the Pick A Truck list, click the truck that you want 
to drive.

3 Click the type of race you want to run.

Monster Truck Madness displays the appropriate race 
screen.

4 Click Garage.

5 Click the tire, suspension, and transfer gear ratio 
settings you want.

Right-click Tip: To find out more about an option, 
place the mouse pointer over the option and click the 
right mouse button.

6 When you are ready to leave the garage, click OK.

{button ,AL(`prerace')} Related Topics



Driving Cheats
Monster Truck Madness offers several "cheats" you can 
use to get a leg up on your competitors during a race. The 
cheats include Auto Shift, Auto Brake, Auto Brake & 
Throttle and Automatic Staging.

To turn on driving cheats
1 On the Options menu, click Game.

Right-click Tip: To find out more about an option, 
place the mouse pointer over the option and click the 
right mouse button.

2 In the Brake & Throttle list, click the driving cheat 
you want.

NOTE: If you click Auto Brake & Throttle, you will 
not be able to put your truck in reverse. If you get into
a situation that you can't get out of, press H to call the
helicopter. It will put you back on track.

3 Click OK.

To stage automatically for a drag race
Before your truck reaches the starting line, press 

S.
Your truck moves forward, stages legally, and comes to 
a halt. All you have to do now is watch for the green 
and go for the gusto!

{button ,AL(`prerace')} Related Topics



Changing the Number of Default 
Opponents
When you set up a race, Monster Truck Madness 
automatically adds several trucks to the list of competing 
trucks for you to face at the starting line.

You can change the number of default opponents that are 
automatically assigned. If you like to hand-pick your 
opponents before every race, you can also set the default 
number to zero.

You can also remove any opponent trucks from the 
Competing Trucks list before you start a race.

IMPORTANT: Changing the number of default opponents 
takes effect immediately if you haven't passed beyond the 
Races screen where you select the type of event you want 
to race. Otherwise, the change takes effect only after you 
have backtracked to the Races screen or to the opening 
screen of the game.

To change the number of default opponents
1 On the Options menu, click Game.

2 In the Number of Default Opponents box, increase or
decrease the number of default opponents.

NOTE: You can specify up to a maximum of seven 
default opponents.

3 Click OK.



Playing Music While Racing
When you play Monster Truck Madness, you have several 
choices for musical accompaniment while you're racing. You 
can:

· Listen to music from the Monster Truck Madness CD-
ROM.

· Listen to music from a music CD.

· Listen to the game's synthesized music. This is handy 
when you don't have the Monster Truck Madness CD-
ROM or any music CDs lying around.

IMPORTANT: If you installed Monster Truck Madness 
using the Typical or Compact option during Setup, you need 
to have the Monster Truck Madness CD-ROM in your CD-
ROM drive to play music during a race.

To listen to music from the Monster Truck Madness CD-
ROM or a music CD
1 Place the Monster Truck Madness CD-ROM disc or a 

music CD in the disc holder (if required), and then 
insert it in your CD-ROM drive.

2 If you inserted a music CD, start Monster Truck 
Madness.

3 On the Options menu, click Sound.

4 Under Sound Track, click Play CD Music Tracks.

5 To confirm that your CD-ROM drive is working 
properly, click Test CD Audio, and then follow the 
directions on your screen.

6 Confirm that the Play Music option is checked.

7 To close the Sound Options dialog box, click OK.

To listen to synthesized music
1 Start Monster Truck Madness, if it is not already 

started.

2 On the Options menu, click Sound.

3 Under Sound Track, click Play Synthesized Music 
Tracks.

4 Confirm that the Play Music option is checked.

5 Click OK.

{button ,AL(`sounds')} Related Topics





Adjusting the Volume of Music and Sound 
Effects
Although the roar of the engines, the screeching of 
monster truck tires, and the hard-driving tunes of the 
Monster Truck Madness sound track are designed to 
optimize your racing experience, you may find that you 
need to turn down the sound every once in a while.

On the other hand, you may find you need to crank up the 
volume. After all, if the windows aren't shaking and the 
neighbors aren't pounding, is there a noise problem? We 
don't think so!

You can control the volume of music and sound effects 
separately.

Keep in mind that the audio race commentary supplied by 
the "Voice of Monster Trucks," Army Armstrong, can also 
be turned off. For details, see Turning Commentary On or 
Off.

To adjust the volume of music and sound effects
1 On the Options menu, click Sound.

2 To adjust the volume of music or sound effects, drag 
the appropriate slider.

-Or-

To turn music or sound effects off entirely, clear the 
Play Music check box or the Play Sound Effects check
box.

3 Click OK.

{button ,AL(`sounds')} Related Topics



Turning Music and Sound Effects On or 
Off
In addition to adjusting the volume of music and sound 
effects, you can also turn them off entirely.

To turn music and/or sound effects on or off
1 On the Options menu, click Sound.

2 To turn music or sound effects off entirely, clear the 
Play Music check box or the Play Sound Effects check
box.

-Or-

To turn music or sound effects back on, click the 
appropriate check box.

{button ,AL(`sounds')} Related Topics



Muting All Sounds
Rather than turning music, sound effects, and commentary 
off one by one, you can mute all of the game's sounds 
simultaneously.

To mute the sound
On the Options menu, click Mute Sound.

-Or-

Press CTRL+M.

To return the sound to its previous level, repeat the 
process.

{button ,AL(`sounds')} Related Topics



Turning Commentary On or Off
While you're competing in any race, you can hear Army 
Armstrong, the "Voice of Monster Trucks," comment on 
the race action.

If you'd prefer the relative quiet of your truck's roaring 
engine over the mellifluous sound of Army's voice, you can 
choose to display his commentary as printed text on the 
screen.

And, if you find the pressure of a master commentator too
much to handle, you can silence Army at any time, in both 
his verbal and text-based forms.

To turn race commentary on or off
1 On the Options menu, click Game.

2 To turn the text display of commentary on or off, 
click Show Commentary to select or clear the option.

3 To turn Army's voice commentary on or off, click Hear
Commentary to select or clear the option.

4 Click OK.

{button ,AL(`sounds')} Related Topics



Turning Race Movies On or Off
Whenever you start Monster Truck Madness, the opening 
movie gives you a heart-stopping glimpse into the fast-
flying, pavement-pounding action of monster trucks. If this 
doesn't get your adrenaline pumping, you're probably 
already dead!

When you battle your way to first place in any of the racing
events, you also get a high-volume, visual reward for your 
efforts.

If you're more interested in getting straight to the racing 
action, you can turn off the opening movie. And, if the thrill
of victory without video enhancement is all you need, you 
can turn off the victory videos as well.

To turn race movies on or off
1 On the Options menu, click Game.

2 To turn the introductory movie on or off, click the 
View Intro Movie checkbox to select or clear the 
option.

3 To turn the victory videos on or off, click the View Clip
Scenes check box to select or clear the option.

4 Click OK.



Turning Automatic Attract Mode On or 
Off
When Automatic Attract Mode is enabled and the game is 
on, something wild happens when you stop working on your 
computer: Monster Truck Madness displays a lively 
selection of race demos and video clips to tempt you back 
to the computer and back on the track!

You can turn off automatic attract mode at any time.

To turn automatic attract mode on or off
1 On the Options menu, click Game.

2 To turn automatic attract mode on or off, click the 
Automatic Attract Mode check box to select or clear 
the option.

3 Click OK.



Drag Racing Tips
· Driving at the rookie level is specifically designed to 

introduce you to the unique physics model of a 5-ton 
monster truck. If you signed in as a rookie and you 
think your truck doesn't have enough get-up-and-go, 
try signing-in as an intermediate. Or, click Garage on 
the race event screen, and then drag the Transfer 
Gear slider to the left, toward More Top-End Speed. 
Experiment until you find the transfer gear setting 
that is most compatible with your driving style.

· If you need to access the menu bar while you are 
racing and it is not displayed, press F4 to display the 
menu bar.

· To switch to a wide-angle, panoramic view of any 
external game view, press MINUS SIGN (-) on the 
main keyboard. To turn off panoramic view, press 
EQUAL SIGN (=).

· If you're not comfortable approaching the starting line
at first, press S to have your truck automatically 
staged.

· Drag racing is all about pure speed and adrenaline, but 
you also have to watch where you're going. You will be 
disqualified if you cross out of your lane or into your 
opponent's lane, or if you leave ahead of the green 
light. If you're driving under the intermediate or 
professional level, you will also be disqualified if you 
don't stage within 30 seconds.

· The Tacoma Dome and the Trans World Dome tracks 
feature J-style drag race tracks. If you're new to drag
racing, start with the simpler, straight tracks before 
you take on the more challenging J-style.

· For advanced tips on staging, see Shallow Versus Deep 
Staging.

{button ,AL(`switch between;skill level')} Related Topics



Straight and J-Style Drag Tracks
Monster truck drag racing began in 1987, after fans grew 
bored with watching monster trucks crush cars. The logical 
next step was to start racing them.

The traditional straight monster truck drag lane has 2 sets
of ramps that lead to two 3-car jumps. The cars that are 
used to build the jumps are called "crush cars," because 
that's what happens to them during a race.

The first ramp sends you flying to the first 3-car jump, 
with the second jump coming up quickly. Once you've 
cleared both jumps, there's nothing to do except speed 
your way to the finish line. Most professional drivers post 
times in the 5-second range. Some of the best have broken 
the 5-second mark.

The J-style tracks at the Tacoma Dome and the Trans 
World Dome add a tight turn between two sections of 
track: The first section is a straightaway with two jump 
ramps followed by the second section with a 5-car jump 
that sends you flying to the finish line.

To watch a video that shows Monster Patrol masterfully 
taking the turns on a J-style track, click the third image in 
the left margin.

{button ,AL(`drag tips;starting;christmas 
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The Drag Race Tracks
No matter how you like to drag—indoor or outdoor, classic 
drag or J-style—Monster Truck Madness has the track 
for you!

Drag 1: B.C. Place
Track: Straight indoor track
Vancouver, British Columbia, Canada
Opening Date: 1983
Capacity: 60,000
Operated By: B.C. Place Stadium

The monster truck tour takes on an international flavor 
when the Bad Boys and Girls with the Bad Toys battle it 
out in B.C. Place every February. With a straight indoor 
drag track like this, national affiliations are unimportant: 
Speed is the universal language!

Drag 2: Indiana State Fairgrounds Grandstand
Track: Straight outdoor track
Indianapolis, Indiana, USA
Opening Date: 1939
Capacity: 14,000
Operated By: Indiana State Fairgrounds Event Center

The monster truck tour tears its way through the 
Fairgrounds every September. One of the oldest venues on
the professional tour, the Fairgrounds boasts one of the 
fastest straight outdoor drag tracks around.

Drag 3: RCA Dome
Track: Straight indoor track
Indianapolis, Indiana, USA
Opening Date: 1984
Capacity: 60,500
Operated By: Indiana Convention Center & RCA Dome

The monsters get their winter workouts on the RCA 
Dome's straight indoor drag track in February and 
November. Hoosiers love their monster trucks, and come in
from the cold to catch 'em! Rumor has it that this is the 
fastest drag track on the tour.

Drag 4: Tacoma Dome
Track: J-style indoor track
Tacoma, Washington, USA
Opening Date: 1983
Capacity: 18,000
Operated By: Tacoma Dome

You can hear the "Thunder in the Dome" when the monster
trucks start the new year in style every January. The 
Tacoma Dome's J-style indoor drag track starts with a 
straightaway, followed by a tight J-turn that sends your 



truck onto a crush car ramp with the finish line just ahead.

Drag 5: Trans World Dome
Track: J-style indoor track
St. Louis, Missouri, USA
Opening Date: 1995
Capacity: 67,000
Operated By: St. Louis Convention and Visitors 

Commission
The roar of the crowd is deafening when hometown hero 
BIGFOOT heads to the starting line for J-style indoor 
drag racing every January. J-style tracks start with a 
straightaway followed by a tight J-turn that sends your 
truck onto a crush car ramp and propels you to the finish 
line.

{button ,AL(`straightj')} Related Topic

Drag Race Qualifying, Heats, and the 
Draw
Depending on the number of trucks you're racing against, 
you may have to battle your way through several racing 
heats to earn the right to race in the final round and go for
the big championship points.

The first order of business in a drag race is to set the 
order of the draw, in which the trucks are paired up to 
race in heats. To set the order of the draw, each truck 
races against the clock and completes a solo qualifying run 
on the track. The qualifying heats are all run 
simultaneously; once you finish your qualifying run, Monster 
Truck Madness displays the qualifying times of all 
competing trucks.

Track officials rank the qualifying times and assign 
positions in the draw.

A fast qualifying time can mean that you'll be assigned a 
good position in the draw, competing against trucks with 
slower qualifying times. The reverse, of course, is also true;
a slow qualifying time can mean that you'll be racing against
opponents with faster qualifying times.

After each heat is run, the Draw screen shows the winners 
and losers of each heat, their times, and who they'll be 
competing with next. With the Draw screen, you always 
know who's due up at the starting line for the next race.

If you're not participating in the next heat, you're not 



required to watch the action on the track. If you choose 
not to watch, the Draw screen updates automatically to let 
you know the heat results.

To skip viewing a drag race heat
On the Draw screen, when "NEXT UP" is displayed 

for the drag race heat that you want to skip, click Skip.
The Draw screen updates to give you the results.

NOTE: You cannot skip heats that you are racing in.

{button ,AL(`staging;straightj;drag tips;christmas 
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Staging for the Drag
Staging is one of the biggest challenges new monster truck 
drivers face. If you're not up to the challenge, use the 
automatic staging feature.

If you want to stage yourself, inch your monster truck 
precisely up to the drag race starting line within 30 
seconds. Don't cross the starting line prematurely 
(redlighting), or you will be disqualified.

To stage automatically
Before your truck reaches the starting line, press 

S.
Your truck moves forward, stages legally, and comes to 
a halt. All you have to do now is watch for the green 
and go for the gusto!

To stage like a pro
NOTE: Use the christmas tree starting signal overlay in 
the upper left corner of your screen to get feedback as 
you are trying to stage.

1 First, get a good view of the staging lines and the 
track: Press V until you are in Goodyear blimp view and 
can see the staging lines in front of your truck. (You 
can stage from Goodyear blimp view, or stage from 
another view.)

2 Crawl forward slowly to the nearest line, the 
prestaging line.

The orange prestage light, the light at the top if the 
christmas tree, illuminates.

3 Roll forward to the next line, the staging line.

The orange stage light, directly beneath the prestage 



light, lights up.

4 When the green light illuminates, give it the gas!

{button ,AL(`stagestrat;new race;christmas 
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Shallow Versus Deep Staging
Staging is a good example of an area where practice and 
persistence can lead to success.

One key factor to keep in mind when staging for a drag 
race is the concept of "rollout," which refers to the 
distance your truck must move down the track before it 
crosses the starting line guard beam.

If you stage shallowly, that is, if you stop immediately 
when the stage light comes on, you have the chance for a 
good rollout: You can accelerate and get your truck moving 
before it crosses the starting line guard beam. In other 
words, you get a running start. The biggest challenge is to 
avoid crossing the starting line guard beam before the 
green light flashes. If you break the beam prematurely, 
you will be disqualified.

If you stage deeply, you start the race closer to the 



starting line, and therefore have less room to build 
momentum before the green light is lit.

Staging shallowly may look foolish to the untrained eye, 
but in reality, it's a smart move.

{button ,AL(`staging;drag tips;christmas tree')} Related 
Topics

The Christmas Tree Starting Signal
If you want to make a name for yourself as a monster truck
drag racer, you need to know how to react with lightning 
quickness to the flashing lights of the christmas tree, an 
electronic starting system.

The starting system uses electronic beams to detect your 
truck's exact location as you move toward the starting line 
in response to the prestage and stage lights. There are two
vertical rows of lights; the driver in the left lane watches 
the row of lights on the left and the driver in the right lane
watches the row on the right.

· Prestage light. This orange light at the top of the 
tree lights up when your front tires cross the prestage
line.



· Stage light. This second orange light illuminates when
your front tires cross the staging line. Be careful! Your
truck is now just inches from the guard beam, which 
serves as the starting line. You will be disqualified if 
you cross the beam before the green light illuminates.

Once both trucks in a drag light their prestage and 
stage lights, the official race starter presses a button 
to activate the lights on the rest of the tree. 

· Yellow lights. These lights flash approximately one-
half second before the green start light flashes.

· Green start light. This is the light you've been waiting 
for! When you see the green start light flash, it is time
to put your monster where your mouth is and peel out! 
Winners are often the first one off the mark, so don't 
get left behind! 

· Red Light. You don't ever want to see this light. If you 
do, it means you've "redlighted"; you've crossed the 
guard beam before the start light has flashed. You 
have been disqualified from the race.

You will be disqualified from a drag race for any of the 
following reasons:

· Not staging within the allotted timeframe. If you are 
driving under the intermediate or professional skill 
level, you will be disqualified if you fail to stage within 
30 seconds. Don't dilly dally.

· Leaving your lane at any time during a drag race. Stay 
in your lane when you're racing, and resist the urge to 
go over and say hello to your fans.

· Crossing the guard beam before the green start light 
illuminates.

A couple of notes on disqualifications:

· If you're driving as a rookie in any drag racing heat, 
Monster Truck Madness cuts you some slack; you can 
fail to stage in time and Monster Truck Madness will 
offer a couple of options for redemption. You can 
accept the maximum qualifying time, or keep trying 
until you get it right. 

· During your initial solo qualifying run, you can disqualify
yourself as many times as you want and still rerun the 
race, regardless of the skill level you signed in under. 

{button ,AL(`starting;drag tips;staging;stagestrat')} 
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Circuit Racing Tips
· Driving at the rookie level is specifically designed to 

introduce you to the unique physics model of a 5-ton 
monster truck. If you signed in as a rookie and you 
think your truck doesn't have enough get-up-and-go, 
try signing-in as an intermediate. Or, click Garage on 
the race event screen, and then drag the Transfer 
Gear slider to the left, toward More Top-End Speed. 
Experiment until you find the transfer gear setting 
that is most compatible with your driving style.

· If you need to access the menu bar while you are 
racing and it is not displayed, press F4 to display the 
menu bar.

· To switch to a wide-angle, panoramic view of any 
external game view, press MINUS SIGN (-) on the 
main keyboard. To turn off panoramic view, press 
EQUAL SIGN (=).

· You MUST pass through all of a circuit's checkpoints 
in order to finish the race legally. While you are 
driving, press F to display the handy directional 
finder, which points you to the next checkpoint.

· Once the first place finisher has crossed the finish 
line, all other trucks are on their last lap. Once you've 



crossed the finish line, your view switches to 
automatic race camera view, where you can relive a 
little of the thrill of your driving performance.

· If you stray from the track, you can call the 
helicopter to bring you back to the track. Press H, and
the whirly bird will come in for the big ride!

· To familiarize yourself with a track, observe how the 
computer trucks take the turns and straightaways. 
While you are driving, press K to switch to another 
truck's point of view. To switch between racing views 
for the current truck, press V. To get back to the cab
of your truck, press CTRL+1.

· To display an overlay map of the track, press TAB. 
Your truck is displayed as a yellow dot, and you can see
where you are in relation to your opponents.

· To display the pit board, press O. The pit board gives 
you details on your time, lap number, and position in 
the race.

· If you turn on race commentary, Army Armstrong will 
let you know when you've missed a checkpoint!

· Shortcuts are legal, as long as you hit all your 
checkpoints!

· Experiment with different race views. You may find 
you prefer chase near view to cockpit view. Press V to 
switch between race views for the current truck.

{button ,AL(`circuit tracks;finder;pit board;views;skill 
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The Circuit Tracks
Each of the circuit tracks offers unique challenges and 
diverse terrain. Try 'em all!

A Crazy Eight

This is a great circuit for the first-time monster trucker. 
Enjoy its flat terrain, long, straight runs, and easy jumps. 
Whet your racing appetite, and see what your monster 
truck can really do. If you're a speed demon, this is the 
track for you! Watch out for construction, though!

Canyon Adventure

Hone your turning and passing skills on this fairly forgiving 



track. With the steep walls of the canyon on both sides of 
you, there's less room to maneuver on the curves. When 
you battle for position on the inside track, there may be 
casualties. Will it be you or your opponents? There's only 
one way to find out: The Canyon awaits.

Mud Pies

This wet and wild circuit sets you down in the weird and 
woody Pacific Northwest. Forge the mighty River Sloma, 
careen over crush cars, power bounce your way across mud 
moguls, rocky roads, and log pile lanes before catching air 
off Jelen Jump and flying by the grandstands to finish a 
lap.

Round and Round

Long stretches of straightaway tempt you to floor it on 
this circuit, but be forewarned: At the end of each long, 
straight stretch awaits a menacing loop that can chew you 
up and spit you out faster than you can yell "Yeehaw." If 
you can drive with discipline on this track's curves, you're 
ready for the big time!

Winding Way

This curvy course with treacherous turns is nestled in the 
gently sloping foothills of the McDowell mountain range. 
You'll be tempted to accelerate, but the wide dirt track is 
surprisingly unforgiving. Jump a stone bridge, rinse your 
truck in Lake Evans, and torque it through the tunnel on 
your way to the finish line.
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Using the Directional Finder to Find Your 
Next Checkpoint
When you're not certain where your next circuit or rally 
checkpoint is, use the handy directional finder to point you 
in the right direction. The directional finder is a reliable 
"as-the-crow-flies" pointer to the next checkpoint. It also 
displays the number of your next checkpoint.

You can display the directional finder at any time, and if 
you stray from the track for more than 5 seconds, it 
automatically appears to point you back to the track.

To display or hide the directional finder

Press F.
-Or-

On the View menu, click Directional Finder.



Reading the Pit Board
You can display the pit board at any time while you are 
competing in a rally or circuit race. The pit board provides 
feedback for the current truck.

To display or hide the pit board



Press O.
The pit board indicators are different for circuits and 
rallies. The following tables describe the indicators for 
both race types.

The Circuit Pit Board

Indicator Feedback for Current Truck
Lap Indicates the time elapsed during the 

last completed lap.

Best Indicates the best lap time for this 
race.

Clock Indicates the elapsed time for the 
race.

Place Indicates the race position as of the 
last checkpoint. 

Back or Lead Indicates the amount of time behind 
the lead or ahead of the competition.

Lap #/# Indicates the current lap and the 
total number of laps in the race.

The Rally Pit Board

Indicator Feedback for Current Truck
Place Indicates the race position as of the 

last checkpoint. 



Clock Indicates the elapsed time for the 
race.



Viewing Truck Positions in Rallies and 
Circuits
Whenever you're driving in a rally or circuit race, you can 
display a miniature map of the course. Moving dots 
represent all competitors and their positions on the track. 
The dot representing your truck is displayed in flashing 
yellow at your truck's current track position. 

If you need more details, you can also choose to display 
truck name labels on the map overlay. The labels include the
current race position of each truck in parentheses.

To… Press
Display the overlay map TAB once

Display truck name labels TAB twice

Hide the overlay map TAB a third time

{button ,AL(`displaying;views')} Related Topics



Rally Racing Tips
· Driving at the rookie level is specifically designed to 

introduce you to the unique physics model of a 5-ton 
monster truck. If you signed in as a rookie and you 
think your truck doesn't have enough get-up-and-go, 
try signing-in as an intermediate. Or, click Garage on 
the race event screen, and then drag the Transfer 
Gear slider to the left, toward More Top-End Speed. 
Experiment until you find the transfer gear setting 
that is most compatible with your driving style.

· If you need to access the menu bar while you are 
racing and it is not displayed, press F4 to display the 
menu bar.

· To switch to a wide-angle, panoramic view of any 
external game view, press MINUS SIGN (-) on the 
main keyboard. To turn off panoramic view, press 
EQUAL SIGN (=).

· You MUST pass through all of a rally's checkpoints in 
order to finish the race legally. While you are driving, 
press F to display the handy directional finder, which 
points you to the next checkpoint.

· Once you've crossed the finish line, your view switches
to automatic race camera view, where you can relive a 



little of the thrill of your driving performance. The 
race ends automatically three seconds after the last 
human-controlled truck crosses the finish line. 

· If you stray from the track, you can call the rescue 
helicopter to bring you back to the track. Press H, and
the whirly bird will come in for the big ride!

· To familiarize yourself with a track, observe how the 
computer trucks take the turns and straightaways. 
While you are driving, press K to switch to another 
truck's point of view. To switch between racing views 
for the current truck, press V. To get back to the cab
of your truck, press CTRL+1.

· To display an overlay map of the track, press TAB. 
Your truck is displayed as a yellow dot, and you can see
where you are in relation to your opponents.

· To display the pit board, press O. The pit board gives 
you details on your time and position in the race.

· If you turn on race commentary, Army Armstrong will 
let you know when you've missed a checkpoint!

· Shortcuts are legal, as long as you hit all your 
checkpoints!

· Experiment with different race views. You may find 
you prefer chase near view to cockpit view. Press V to 
switch between race views for the current truck.

{button ,AL(`finder;pit board;skill 
level;comments;views;rally tracks')} Related Topics



The Rally Tracks
See the world (or at least the muddy parts), from the 
comfort of your monster truck cockpit. The rally races 
offer a wide range of geographical challenges.

Arizona

The hot sands of the Arizona desert await the brave and 
hearty monster trucker. If you can't stand the heat, get 
out of this rally now! Hurtle past cacti and canyons, and 
visit a ghost town or two. When you hit the four-lane 
blacktop, prepare to make some adjustments. This is where
the rubber really meets the road!

Highlands Rally



Maneuver your monster through verdant farmland dotted 
with quaint thatch-roofed cottages and cobblestone 
streets. Admire the scenery as you wind your way through 
this land of lochs. Those who explore will be rewarded!

Yucatan Adventure

This rally is designed for the confident monster trucker. 
The Yucatan offers a variety of terrain, from paved roads 
and sandy beaches to the crushed lava rock of a live 
volcano. Turns are sharp and numerous and the terrain is 
hilly, especially just before turns. The variety of driving 
conditions, combined with the high number of treacherous 
turns and spectacular jumps, calls for someone who really 
knows how to handle a monster truck. Are you up to the 
challenge?

{button ,AL(`rally tips')} Related Topic



Using the Directional Finder to Find Your 
Next Checkpoint
When you're not certain where your next circuit or rally 
checkpoint is, use the handy directional finder to point you 
in the right direction. The directional finder is a reliable 
"as-the-crow-flies" pointer to the next checkpoint. It also 
displays the number of your next checkpoint.

You can display the directional finder at any time, and if 
you stray from the track for more than 5 seconds, it 
automatically appears to point you back to the track.

To display or hide the directional finder



Press F.
-Or-
On the View menu, click Directional Finder.



Reading the Pit Board
You can display the pit board at any time while you are 
competing in a rally or circuit race. The pit board provides 
feedback for the current truck.

To display or hide the pit board



Press O.
The pit board indicators are different for circuits and 
rallies. The following tables describe the indicators for 
both race types.

The Circuit Pit Board

Indicator Feedback for Current Truck
Lap Indicates the number of completed 

laps

Best Indicates the best lap time for this 
race

Clock Indicates the elapsed time for the 
race

Place Indicates the race position as of the 
last checkpoint

Back or Lead Indicates the amount of time behind 
the lead or ahead of the competition

Lap (located in the Indicates the current lap number
bottom section 
of the pit board)

The Rally Pit Board

Indicator Feedback for Current Truck
Place Indicates the race position as of the 

last checkpoint



Clock Indicates the elapsed time for the 
race



Viewing Truck Positions in Rallies and 
Circuits
Whenever you're driving in a rally or circuit race, you can 
display a miniature map of the course. Moving dots 
represent all competitors and their positions on the track. 
The dot representing your truck is displayed in flashing 
yellow at your truck's current track position. 

If you need more details, you can also choose to display 
truck name labels on the map overlay. The labels include the
current race position of each truck in parentheses.

To… Press
Display the overlay map TAB once

Display truck name labels TAB twice

Hide the overlay map TAB a third time

{button ,AL(`displaying;views')} Related Topics



Tournament Racing Tips
· Driving at the rookie level is specifically designed to 

introduce you to the unique physics model of a 5-ton 
monster truck. If you signed in as a rookie and you 
think your truck doesn't have enough get-up-and-go, 
try signing-in as an intermediate. Or, click Garage on 
the race event screen, and then drag the Transfer 
Gear slider to the left, toward More Top-End Speed. 
Experiment until you find the transfer gear setting 
that is most compatible with your driving style.

· If you need to access the menu bar while you are 
racing and it is not displayed, press F4 to display the 
menu bar.

· To switch to a wide-angle, panoramic view of any 
external game view, press MINUS SIGN (-) on the 
main keyboard. To turn off panoramic view, press 
EQUAL SIGN (=).

· Look for tournaments that include your favorite racing
events on your favorite tracks. You're more likely to 
excel (and accelerate!) on tracks you've driven often.

· The tournaments that come with Monster Truck 
Madness were especially designed by experts to 
challenge your monster truck driving skills. The 



tournament descriptions can help you find the type of 
challenge you're looking for.

· If you love every race in a tournament except one, 
create your own custom tournament and delete the one
track you always have trouble with.

{button ,AL(`CustomTourny;changetourny')} Related 
Topics



Creating a Custom Tournament
If battling through the challenges of the action-packed 
tournaments that come with Monster Truck Madness isn't 
enough for you, create custom tournaments.

You choose the events and the order in which they are run.

Once you've created, named, and saved a custom 
tournament, its name is added to the list of tournaments in
the Select Tournament list on the Tournament screen.

To create, name, and save a custom tournament
1 On the Monster Truck Madness opening screen, click 

Races.

2 On the Races screen, click Tournament.

3 On the Tournament screen, click Custom.

4 Click New.

The text, "Untitled Tournament," appears in the Name
of Tournament list.

5 Highlight Untitled Tournament and type a unique name
for the tournament you're creating. You can include 
spaces and punctuation.

6 In the Description box, type a brief description of the
tournament you're creating.

7 In the Events list, click the first racing event you 
want to run in the tournament, and then click Add. 
Repeat for each event you want to add.

NOTE: Tournament events will occur in the order in 
which they are listed in the Selected Events box.

8 If you add a circuit race, you can change the number 
of laps. Highlight the circuit in the Selected Events 
list, and adjust the number of laps in the Laps box.

9 To save the custom tournament, click Save.

10 On the Custom Tournament screen, click Back.

{button ,AL(`changetourny')} Related Topic



Making Changes to an Existing 
Tournament
You can make changes to any tournament you've created. 

To modify a tournament
1 On the Monster Truck Madness opening screen, click 

Races.

2 On the Races screen, click Tournament.

3 On the Tournament screen, click Custom.

4 In the Name of Tournament list, click the tournament
you want to change.

NOTE: You cannot make changes to the tournaments 
that come with Monster Truck Madness.

5 Next, type a new name in the Name of Tournament 
list.

6 In the Description box, type a brief description of the
tournament you're creating.

7 To remove any event listed in the Selected Events 
list, click the event, and then click Remove.

8 To add an event to the Selected Events list, you have 
two choices: You can keep the existing order of events
and add new events only to the end of the list, or you 



can click Remove until the events list is empty and 
then click Add to add events in the order you want to 
race them.

9 If you add a circuit race, you can change the number 
of laps. Highlight the circuit in the Selected Events 
list, and adjust the number of laps in the Laps box.

10 To save the custom tournament, click Save.

11 On the Custom Tournament screen, click Back.

{button ,AL(`CustomTourny')} Related Topic



Custom Tournament Racing Tips
· If you love every race in a tournament except one, 

create your own custom tournament and delete the one
track you always have trouble with.

· Create a custom tournament that tests and challenges 
all your driving skills, and then use it as a training 
device for new players.

· Check the Microsoft Monster Truck Web Stop for 
postings of custom tournaments created by Monster 
Truck Madness players from all over the world.

http://www.microsoft.com/games/monster/

{button ,AL(`CustomTourny;changetourny')} Related 
Topics



Scoring: Drag Races
All drag races use the Penda Point System for scoring.

In drag racing, you have several opportunities to earn 
maximum points as you race head-to-head against a series 
of competitors.

Scoring Points for Your Qualifying Run
Each monster truck participating in a drag race must first 
complete a solo run on the track to record a qualifying 
time, which is then used to set the order of the drag race 
draw.

You earn points in a qualifying run as follows:

· 100 points for fastest qualifying time

· 90 points for second fastest qualifying time

· 80 points for third fastest qualifying time

· 70 points for fourth fastest qualifying time

· 60 points each for the fifth, sixth, seventh, and 
eighth fastest qualifying times

Scoring Points for the Preliminary Heats
Winners of a drag race in the preliminary heats of 
competition earn 250 points for each victory, while losers 
earn 200 points, even if all they do is show up and stage. If



you red-light for any reason, you don't earn any points.

Scoring Points for the Final Round
If you're skilled enough to battle your way to the final 
round and win a drag race competition, you earn the 
following points for your trouble:

Number of trucks competing Points earned for win
8 trucks 350

4 trucks 300

2 trucks 250

If you make it this far only to eat the dust of another 
truck, you may find comfort in the fact that, even in 
losing, you earn 200 points.

Scoring Points for the Fastest Preliminary Heat
The truck that posts the fastest time in a nonqualifying, or
preliminary, heat is awarded an additional 50 points.

A Perfect Drag Race Score
A perfect day at the drag race track earns you 950 points 
(plus bragging rights, which are invaluable!). A perfect 
score breaks down like this:

· 100 points for the fastest qualifying time.

· 250 points for winning each of the preliminary heats 
for a total of 500 points. Keep in mind, though, that 
there are 2 preliminary heats only if 8 trucks are 
competing. If you choose to compete in 2-truck or 4-
truck drag competitions, your perfect score will be 
less.

· 350 points for winning the final race in an 8-truck 
competition.

· 50 points for posting the fastest nonqualifying run 
time. NOTE: you can't score in this category if you 
also recorded the fastest qualifying time.

{button ,AL(`scoring')} Related Topics
 



Scoring: Circuit Races
In circuit races, drivers score points based on who is first 
to pass through all the checkpoints, complete all the laps, 
and fly across the finish line.

One crucial thing to keep in mind when circuit racing: You 
must pass through each of the checkpoints for each lap 
before you make it to the finish line. When you cross a 
checkpoint successfully, you hear a noise to confirm the 
crossing. If you miss a checkpoint, you won't be awarded 
points for finishing the race.

Once the first-place finisher crosses the finish line,    the 
rest of the drivers are on their last lap. The race ends 
three seconds after the last human player crosses the 
finish line.

Once you've crossed the finish line, your view switches to 
automatic race camera view, where you can relive a little of
the thrill of your driving performance.

You earn circuit race points as follows:

· 900 points for first place

· 700 points for second place

· 500 points for third place

· 400 points for fourth place



· 300 points for fifth place

· 200 points for sixth place

· 150 points for seventh place

· 100 points for eighth place

Earning Points for Leading a Lap
For each circuit race, Monster Truck Madness awards a 
total of 100 points for maintaining the lead for an entire 
lap. The number of points you earn for leading a lap 
depends on the number of laps in the race. For example, in 
a 5-lap circuit race, trucks that maintain the lead for an 
entire lap are awarded 20 points (100 points divided by the
number of laps).

Earning Points for the Fastest Lap
Regardless of your ultimate position in a circuit race, you 
can also earn 100 points for posting the fastest lap time in 
the race.

A Perfect Circuit Race Score
A perfect score for a circuit race is 1100 points; 900 for 
the first place win, 100 points for leading all laps, and 100 
points for recording the fastest lap time.

{button ,AL(`scoring')} Related Topics



Scoring: Rally Races
In rally races, drivers score points based on who 
successfully passes through all the checkpoints and flies to
the finish line first.

One crucial thing to keep in mind when rally racing: You 
must pass through each rally checkpoint before you cross 
the finish line. When you cross a checkpoint successfully, 
you hear a noise to confirm the crossing. If you miss a 
checkpoint, you won't be awarded points for finishing the 
race.

Once you've crossed the finish line, your view switches to 
automatic race camera view, where you can relive a little of
the thrill of your driving performance. The race ends 
automatically three seconds after the last human-
controlled truck crosses the finish line.

You earn rally race points as follows:

· 400 points for first place

· 300 points for second place

· 250 points for third place

· 200 points for fourth place

· 175 points for fifth place

· 150 points for sixth place



· 125 points for seventh place

· 100 points for eighth place

Earning Points for Fastest Time Between Checkpoints
For each rally race, Monster Truck Madness awards a total
of 500 points for recording the fastest time between 
checkpoints. The number of points you get depends on the 
number of checkpoints in the race. For example, in a rally 
race with 5 checkpoints, trucks that record the fastest 
times between each checkpoint are awarded 100 points 
(500 points divided by the number of checkpoints).

A Perfect Rally Race Score
A perfect rally race score is 900 points, 400 for the first 
place win and 500 points for recording the fastest time 
between each checkpoint.

{button ,AL(`scoring')} Related Topics



Scoring: Tournaments
The total number of points you can earn competing in a 
tournament depends on the number and type of races 
included in the tournament.

In all tournaments, points for individual racing events are 
calculated according to the scoring system associated with
the race type.

{button ,AL(`scoring')} Related Topics





Hall of Fame: Viewing High Scores
Go to the Hall of Fame to gloat (or weep) over the 
chronicle of your past performances.

The Hall of Fame displays the top 12 performances for 
drags, circuits, rallies, and tournaments. The Hall of Fame 
identifies the truck you drove when you won, as well as the
skill level you raced under.

For circuits, you can see who has clocked the best lap time 
as well as who has the best average lap time.

For rallies, you can check out who recorded the fastest 
total elapsed time for a race.

To view high scores in the Hall of Fame
1 On the Race menu, click Hall of Fame.

2 Click the tab for the type of race for which you want 
to view high scores.

3 In the Track list, click the name of the track for 
which you want to see Hall of Fame information.

4 When you are finished, click Close.

{button ,AL(`scoring')} Related Topics



Instant Replay: Reliving the Races!
You can save video clips of your best—and worst—monster 
truck moments.

As you're racing, Monster Truck Madness automatically 
records the race action for all the participating trucks. 
Depending on the available memory on your computer, as 
much as the last 30 seconds of racing action is stored at a 
time. You can play your own racing performance or those of 
any of your competitors.

So, when something unforgettable happens on the track, 
save the recording right away! If you wait too long, you may
lose the chance to see and save the video proof of your 
performance.

To review instant replay action during a race
1 While you are racing, press P to pause the race.

2 Click Replay.

3 To rewind or fast-forward the tape, or to play it in 
slow motion, use the VCR-like controls.

Right-Click Tip: To find out more about a camera 
angle or VCR control, place the mouse pointer over the 
control and click the right mouse button.

4 For a different perspective on the action, in the 



Camera list, select a new position for the camera.

5 To see the race action from another truck's 
perspective, select a truck in the Truck list.

6 Experiment with different camera angle views by 
clicking the controls under Camera Angles.

The zoom in, zoom out, rotate left and right, rotate up 
and down camera angle controls are not available if you 
select the Cockpit View camera angle. The same is true
in drag races for the Race Cam, Drag Starting Line, 
Drag Finish Line, and Drag Spectator Stands camera 
angles.

7 When you are finished, click Close.

{button ,AL(`instantreplay')} Related Topics



Saving an Instant Replay File
Monster Truck Madness automatically records all the race 
action. But, only as much as the last 30 seconds of racing 
action is stored at a time. So, it's a good idea to pause the 
race and save that memorable monster truck moment 
quickly, before it's gone forever!

To save an instant replay file for later viewing
1 As soon as you've done something you want to save, 

press P to pause the race.

2 Click Replay.

Monster Truck Madness displays the Instant Replay 
screen.

3 Click Save.

4 In the File Name box, type a name for the instant 
replay file. You can include spaces and punctuation.

Instant replay files use the three-character 
extension .RPL. You don't need to type the filename 
extension.

5 Click Save.

The file is saved and you return to the Instant Replay 
screen.

{button ,AL(`instantreplay')} Related Topics



Playing a Previously Saved Instant Replay 
File
If you've saved a particularly juicy video clip or traded 
Monster Truck Madness instant replay files with friends, 
you can replay them at any time.

To play a previously saved instant replay file
1 On the View menu, click Instant Replay.

2 Click Open.

3 Double-click the instant replay file. Instant replay files
use the three-character extension .RPL.

Use the Instant Replay screen's VCR and Camera 
Angle controls to view your video clip.

Right-Click Tip: To find out more about a camera 
angle or VCR control, place the mouse pointer over the 
control and click the right mouse button.

4 When you are finished, click Close.

{button ,AL(`instantreplay')} Related Topics





Multiplayer Racing Overview
You can race rallies and circuits against other players over 
a Local Area Network (LAN) connection, via a modem 
connection, or an Internet connection.

When you play over a LAN, you can compete with up to 
seven other players. 

When you connect via a one-to-one modem connection, two 
people on two different computers can race head-to-head. 

When you race players over the Internet (for most people,
their Internet connection is via modem), you can compete 
with up to seven other players, depending on the type and 
speed of your connections. Internet play can be 
accomplished by using a matchmaker service, or by players 
sharing their IP addresses to make direct connections via 
the Internet to each other's computers.

You can either host or join a race. When you host a racing 
event, you control who participates and what type of race 
you compete in.

Several things to keep in mind about multiplayer racing:

· Once the race is started, there's no going back! You 
cannot pause the game or fire up the Monster Manual.

· You cannot race drags or tournaments in multiplayer 



racing.

· To really spice up the action, in addition to human 
opponents, you can add computer trucks to multiplayer
races.

· If a player quits while a race is in-progress or 
otherwise disconnects his or her computer, or the 
modem connection drops out, the computer takes over 
control of that exiting player's truck. If the host 
quits while a race is in-progress or otherwise 
disconnects his or her computer, the race ends for all 
participants.

{button ,AL(`multiplayer;speed')} Related Topics



Hosting a Race Via a One-to-One Modem
Connection
If you have a direct, one-to-one modem connection to 
another player, you can host a head-to-head circuit or rally
race.

Monster Truck Madness requires, at a minimum, a 14.4 
kbps modem. However, even with a 14.4 kbps modem, you 
may experience degraded performance. A 28.8 kbps 
modem for all participants is strongly recommended.

IMPORTANT: When you host a race, the player joining 
you must dial up your computer and establish a modem 
connection before the race can begin. It is a good idea to 
plan ahead. Make sure your opponent knows you will be the 
host. Agree that you will get a few moments head start to 
begin setting up the game.

To host one other player via a modem
1 On the Monster Truck Madness opening screen, 

select a driver name for yourself and the skill level for
both you and your opponent.

2 Click Multiplayer.

3 Click Host.

4 In the Game Session Name box, type a descriptive 
name for the racing session. 

5 In the Select A Connection Type list, click Modem 
Connection.

6 Click OK.

7 In the Available Players box, click the player you want
to race against, and then click Add.

NOTE: You may have to wait while your opponent 
establishes a modem connection.

8 Click OK.

9 On the Races screen, pick the truck you want to drive,
and then click either Circuit or Rally.

The appropriate race screen is displayed with you and 
your opponent(s) listed in the Competing Trucks list.

10 If you are racing a rally, in the Select Rally list, click 
the name of the rally you want to race.

-Or-

If you are racing a circuit, in the Select Track list, 
click the name of the track you want to race on. Then, 
specify the number of laps you want.

11 When you're ready to race, click Race.

The race begins when your opponent clicks Race.



{button ,AL(`multiplayer;garage options;speed')} Related 
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Joining a Race Via a One-to-One Modem 
Connection
When you join a race via a one-to-one modem connection, 
the host selects the type of race, while you select a driver
name and which truck you want to drive.

Monster Truck Madness requires, at a minimum, a 14.4 
kbps modem. However, even with a 14.4 kbps modem, you 
may experience degraded performance. A 28.8 kbps 
modem for all participants is strongly recommended.

IMPORTANT: To join, you dial up the host computer, and 
wait for the host to include you as a participant and to set 
up the racing event. It is a good idea to plan ahead. Call one
another and agree on who is hosting and give the host a 
little advance start to set up the game.

To join a race via a one-to-one modem connection
1 On the Monster Truck Madness opening screen, 

select or type a driver name.

2 Click Multiplayer.

3 Click Join.

4 In the Select A Connection Type list, click Modem 
Connection.

5 Click OK.

6 Click OK.

7 In the Phone Number box, type the telephone number
of the computer that is hosting the race.

8 Click Dial.

Your modem tries to establish a connection with the 
host's computer. Once the connection has been 
established, wait while the host officially adds you as 
a participant. When everything is set, the Races 
screen is displayed.

9 On the Races screen, pick the truck you want to drive.

10 When the Next button lights up, click it.

Depending on the race type your host chose, Monster 
Truck Madness displays either the Circuit or Rally 
screen, where you can preview the track your host has 
chosen; or, you can go to the garage to tweak your 
truck.

11 When you are ready to race, click Race.

{button ,AL(`multiplayer;garage options;speed')} Related 
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Hosting a Race Via a LAN Connection
If you have a LAN, you can either use the WinSock IPX or 
the WinSock TCP protocol connection to host a race. The 
protocol connection you should use depends on which 
protocols are installed on your machine.

The race you host can be against one or up to a maximum 
of seven other players.

IMPORTANT: When you host a race, the players joining 
you must establish connections before the race can begin. 
It is a good idea to plan ahead. Call one another, agree on 
the protocol connection type you'll use, and make sure your
opponent(s) know you will be the host and what you will call 
the game session. Agree that you will get a few moments 
head start to begin setting up the game.

To host a race via a LAN Connection
1 On the Monster Truck Madness opening screen, 

select a driver name for yourself and the skill level for
all participants.

2 Click Multiplayer.

3 Click Host.

4 In the Game Session Name box, type a descriptive 
name for the racing session.

5 In the Select A Connection Type list, click WinSock 
TCP Connection or WinSock IPX Connection. Select 
the option that matches your protocol.

6 Click OK.

7 In the Available Players list, click the player(s) you 
want to race against, and then click Add. Repeat for 
each player you want to add.

NOTE: You will have to wait while your opponent(s) 
establish connection(s). You can add up to seven 
players.

8 Click OK.

9 On the Races screen, select the truck you want to 
drive, and then click either Circuit or Rally.

The appropriate race screen is displayed with you and 
your opponent(s) listed in the Competing Trucks list.

10 If you are racing a rally, in the Select Rally list, click 
the name of the rally you want to race.

-Or-

If you are racing a circuit, in the Select Track list, 
click the name of the track you want to race on. Then, 
specify the number of laps you want.

11 When you're ready to race, click Race.



Monster Truck Madness lists the players who are 
ready to race. The race will not commence until all 
participants are ready.

When the Please Wait… dialog box is displayed, the 
race is about to begin. Get ready!

{button ,AL(`multiplayer;garage options;speed')} Related 
Topics



Joining a Race Via a LAN Connection
If you have a LAN, you can either use the WinSock IPX or 
the WinSock TCP protocol connection to join a race. The 
protocol connection you should use depends on which 
protocols are installed on your machine.

You can join one or up to seven other players in a race that
takes place via a LAN connection.

IMPORTANT: When joining a race via a LAN connection, it
is a good idea to plan ahead. Call one another. Agree on who
is hosting, what protocol connection to use, and what the 
name of the game session will be. It's also a good idea to 
give the host a little advance start to set up the game.

To join a multiplayer race via a LAN connection
1 On the Monster Truck Madness opening screen, 

select or type a driver name.

2 Click Multiplayer.

3 Click Join.

4 In the Select A Connection Type box, click the 
connection type you want.

5 Click OK.

6 In the Select A Game Session To Join list, click the 
name of the game session you want to join.

7 Click OK.

8 On the Races screen, pick the truck you want to drive.

9 When the Next button lights up, click it.

Depending on the race type your host chose, Monster 
Truck Madness displays either the Circuit or Rally 
screen, where you can preview the track your host has 
chosen; or, you can go to the garage to tweak your 
truck.

10 When you are ready to race, click Race.

If there are more than two participants, Monster 
Truck Madness displays a list of players who are ready
to start the race. You may need to wait while all the 
players get set to race.

When the Please Wait… dialog box is displayed, the 
race is about to begin. Get ready!

{button ,AL(`multiplayer;garage options;speed')} Related 
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Hosting a Race Via an Internet 
Connection
To host a race in Internet play, you need an Internet 
account with an Internet Service Provider (ISP), such as 
MSN™, The Microsoft Network online service. You can 
host up to a maximum of seven other participants in 
Internet play.

When setting up a race via an Internet connection, the 
game will run best if you limit the total number of 
participants to four or less. If you want to race with more 
players, all participants should connect via the same ISP, 
such as MSN, or have an ISDN or T1 connection to the 
Internet.

IMPORTANT: If you connect to the Internet via a modem,
the faster the modem, the better. Monster Truck 
Madness requires, at a minimum, a 14.4 kbps modem. 
However, even with a 14.4 kbps modem, you may 
experience degraded performance in the game in Internet 
play. A 28.8 kbps modem for all participants is strongly 
recommended.

When you host a race, the player(s) joining you must 
establish a connection to your computer via the Internet 
and an IP address. (If you don't know your IP address, see 
Finding Out Your IP Address.) Make sure your opponent(s) 
know you will be the host, and agree that you will get a few
moments head start to begin setting up the game.

When you connect to an ISP, you are assigned an IP 
address for that session. Finding a way to tell your 
opponent(s) what your IP address is may require some 
ingenuity and resolve on your part. When you connect to an
ISP via modem, your phone line is tied up. If you and your 
opponents are each fortunate enough to have second phone
lines, no problem! Call them up, tell them your IP address. 
Otherwise, you need to find another way. Some possible 
solutions are to go to chat areas provided by your ISP, or 
to send e-mail. For more tips, you might try going to a 
multiplayer gaming chat group and asking for help there.

To host a race via an Internet Connection
1 On the Monster Truck Madness opening screen, 

select a driver name for yourself and the skill level for
all participants.

2 Click Multiplayer.

3 Click Host.

4 In the Game Session Name box, type a descriptive 
name for this racing session.

5 In the Select A Connection Type list, click Internet 
(TCP/IP) Connection.



6 Click OK.

7 In the Available Players list, click the player you want 
to race against, and then click Add. Repeat for each 
player you want to add.

NOTE: You may have to wait for your opponents(s) to 
establish connection(s). You can add up to seven 
players.

8 Click OK.

9 On the Races screen, click the truck you want to drive,
and then click Rally or Circuit.

The appropriate race screen is displayed with you and 
your opponent(s) listed in the Competing Trucks list.

10 If you are racing a rally, in the Select Rally list, click 
the name of the rally you want to race.

-Or-

If you are racing a circuit, in the Select Track list, 
click the name of the track you want to race on. Then, 
specify the number of laps you want.

11 When you're ready to race, click Race.

Monster Truck Madness lists the players who are 
ready to race. The race will not commence until all 
participants are ready.

When the Please Wait… dialog box is displayed, the 
race is about to begin. Get ready!

{button ,AL(`multiplayer;garage options;speed')} Related 
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Finding Out Your IP Address
The most important thing to remember when hosting a 
race via an Internet connection is that, before you start, 
you need to supply the people you want to race against with
your Internet Protocol (IP) address, which they must use 
to connect to your computer. Before you host a race, 
communicate your IP address to your opponents. Call them 
on the telephone, send them some email, or post a message
in a chat forum.

It is also important to connect to your Internet Service 
Provider (ISP), such as MSN™, The Microsoft Network 
online service, before starting the following procedure. 
Otherwise, your IP address may not be displayed.

IMPORTANT: Print this topic before starting the 
procedure. As you follow the steps below, a dialog box 
appears which may obscure this topic. Refer to the printed
topic to finish the procedure.

To determine your computer's IP address



1 Click  to display the IP 
Configuration dialog box.

The IP address for your computer is listed in the IP 
Address box.

2 Make a note of the IP address.

3 Click OK.

4 Communicate your IP address to the people you want 
to race against.

When you connect to an ISP, you are assigned an IP 
address for that session. Finding a way to tell your 
opponent(s) what your IP address is may require some 
ingenuity and resolve on your part. When you connect to an
ISP via modem, your phone line is tied up. If you and your 
opponents are each fortunate enough to have second phone
lines, no problem! Call them up, tell them your IP address. 
Otherwise, you need to find another way. Some possible 
solutions are chat areas provided by your ISP and e-mail. 
For more tips, you might try going to a multiplayer gaming 
chat group and asking for help there.
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Joining a Race Via an Internet Connection
To join a race in Internet play, you need an Internet 
account with an Internet Service Provider (ISP), such as 
MSN™, The Microsoft Network online service. You can join
one or up to seven other players in Internet play.

IMPORTANT: If you connect to the Internet via a modem,
the faster the modem, the better. Monster Truck 
Madness requires, at a minimum, a 14.4 kbps modem. 
However, even with a 14.4 kbps modem, you may 
experience degraded performance in the game in Internet 
play. A 28.8 kbps modem for all participants is strongly 
recommended.

When you join a race, you must establish a connection to 
your host's computer via the Internet and an IP address. 
Before beginning the following procedure, you and your 
host should work out in advance, how you will find out the 
host's IP address. 

When your host connects to an ISP, the ISP assigns an IP 
address for that session. Finding your host's assigned IP 
address may require some ingenuity and resolve on your 
part. When you connect to an ISP via modem, your phone 
line is tied up. If you and your host are each fortunate 
enough to have second phone lines, no problem! Otherwise, 



you need to find another way. Some possible solutions are 
chat areas provided by your ISP and e-mail. For more tips, 
you might try going to a multiplayer gaming chat group and 
asking for help there.

To join a race via an Internet Connection
1 On the Monster Truck Madness opening screen, type 

or select a name for yourself.

2 Click Multiplayer.

3 Click Join.

4 In the Select A Connection Type box, click Internet 
(TCP/IP) Connection.

5 Click OK.

6 Click OK.

7 In the Specify A Host Name Or IP Address box, 
type your host's IP address.

8 Click OK.

9 On the Races screen, pick the truck you want to drive.

10 When the Next button lights up, click it.

Depending on the race type your host chose, Monster 
Truck Madness displays either the Circuit or Rally 
screen, where you can preview the track your host has 
chosen; or, you can go to the garage to tweak your 
truck.

11 When you are ready to race, click Race.

If there are more than two participants, Monster 
Truck Madness displays a list of players who are ready
to start the race. You may need to wait while all the 
players get set to race.

When the Please Wait… dialog box is displayed, the 
race is about to begin. Get ready!

{button ,AL(`multiplayer;garage options;speed')} Related 
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Chatting with Opponents While You're 
Racing
When you're racing head-to-head against other drivers 
during a multiplayer game, you can exchange snide remarks, 
words of encouragement, or even discuss the current track 
conditions.

You can send chat messages that can be read by all the 
drivers, or you can send private messages to one other 
driver.

Keep in mind, that even as you're typing in messages, you're
still driving, and you still have to control your monster 
truck. You have joystick control while sending a message, 
but you don't have access to some keyboard commands. No 
crashes caused by negligent chatting!

To send a message to all drivers
NOTE: You can start chatting with your opponents once 
the race has begun.

1 To display the Chat Message box, Press T.

2 Type your message in the Chat Message box.

To delete text or make corrections, press BACKSPACE 
key.



3 When you are ready to send your message, press 
ENTER.

To send a private message to a specific driver
1 If the Chat Message box is not already displayed, 

press T.

2 Press the DOWN ARROW key to scroll through the 
list of drivers until the name of the driver you want to 
send to is displayed in the Chat Message box.

3 Type your message. To delete text or make 
corrections, use the BACKSPACE key.

4 When you are ready to send your private message, 
press ENTER.
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Viewing Your Messages
When an opponent sends you a chat message, it is 
automatically displayed in the Incoming Chat window, which
appears in the lower middle of the game window. The 
Incoming Chat window automatically disappears after 10 
seconds, unless you specify that it is displayed for a 
shorter or longer period of time. Monster Truck Madness 
keeps up to 20 received messages in a queue so that you 
can scroll through the messages you've received.

To display and scroll through incoming messages



To display your incoming 
messages, press COMMA (,), and then use COMMA (,) and 
PERIOD (.) to scroll to the next and previous messages.
To display or hide chat messages
1 On the Options menu, click Game.

2 Under Network Chat, select or clear the Show Chat 
Messages check box.

3 Click OK.

To change how long the Chat window stays open
1 On the Options menu, click Game.

2 Under Network Chat, select the Show Chat Messages 
check box.

3 Under Network Chat, in the Seconds Per Message 
box, type the number of seconds you want the Chat 
window to stay up.

4 Click OK.

{button ,AL(`chatting;multiplayer')} Related Topics



Miscellaneous Tips for Making the Game 
Run Faster
· Limit the number of computer trucks you race against.

· Quit all other open applications before starting 
Monster Truck Madness.

· If you are in cockpit view with the rear view mirror 
displayed, hide the rear view mirror by pressing 
MINUS SIGN (-) on the numeric keypad or moving the
hat switch up on a joystick.

· For faster modem-to-modem or Internet gameplay via 
modem, upgrade your modem to a 28.8 kbps (or faster) 
modem.

· When setting up a race via an Internet connection, 
limit the total number of participants to three. If you 
want to race with a total of four players, all 
participants should connect via the same Internet 
Service Provider (ISP), such as MSN™, The Microsoft 
Network online service, or have an ISDN or T1 
connection to the Internet.

· Turn off synthesized music. On the Options menu, click
Sound, and then clear the Play Synthesized Music 
checkbox.



· Play music in mono rather than stereo. On the Options 
menu, click Sound. In the Playback Format list, click 
Mono.

· Turn off all sound effects and music. Press CTRL+M.

· Let Monster Truck Madness determine the graphics 
settings that will make the game run faster. On the 
Options menu, click Graphics, select the Automatic 
Graphics Quality check box, and then drag the 
Graphics Quality Adjuster slider to Runs Faster.

· Set the image quality to low. On the Options menu, 
click Graphics. In the Image Quality list, click Low 
(Faster).

· Set the graphics resolution to 320 x 400 or 320 x 200.
On the Options menu, click Graphics. In the Simulation
Resolution list, click one of the resolution options 
above.

{button ,AL(`speed')} Related Topics



Visiting the Monster Truck Web Stop
If you race to win, you'll get the edge you need at the 
Monster Truck Web Stop!

Check in at the Monster Truck Web Stop to learn tips for 
playing the game and download free videos and 
photographs. Follow the professional monster truck tour 
and get up-to-date race results and standings.

You can visit the Monster Truck Web Stop from the 
game's opening screen.

To visit the Monster Truck Web Stop



On the game's opening 
screen, click Monster Truck Web Stop.

-Or-

If you've gone past the opening screen, click the 
button that looks like this

until you've backtracked to the opening screen, and then 
click Monster Truck Web Stop.
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Changing the Monster Truck Web Stop's 
Internet Address
With the constantly changing and evolving nature of the 
Internet, it's possible that the Internet address, or URL, 
for the Monster Truck Web Stop may change.

If the URL changes for the Monster Truck Web Stop's 
World Wide Web page, you need to update the URL that 
the game uses. That way, when you click the Monster Truck
Web Stop button on the game's opening screen, you'll see 
the correct Web page.

To change the Monster Truck Web Stop's URL
1 On the Options menu, click Game.

2 Under Monster Truck Madness Web Page, type a new 
URL for Monster Truck Web Stop.

NOTE: The current URL is 
http://www.microsoft.com/games/monster/

3 Click OK.

{button ,AL(`web')} Related Topic





Setting Your Monitor to Display 256 
Colors
Monster Truck Madness runs best when your monitor is set
to display 256 colors. If you choose to leave your monitor 
set to higher color modes, it is very likely that Monster 
Truck Madness will not run satisfactorily. However, if you 
use a 3D hardware graphics accelerator, you may be able to
get satisfactory performance in higher color modes.

NOTE: Your monitor and display adapter determine 
whether you can change your screen resolution.

IMPORTANT: Print this topic before starting the 
procedure. As you follow the steps below, a dialog box 
appears which may obscure this topic. Refer to the printed 
topic to finish the procedure.

To set your monitor to display 256 colors



1 Click  to display the 
Display Properties dialog box.

2 In the Color Palette list, click 256 Color.
3 Click OK.
IMPORTANT: Depending on how your system is 
configured, you may be prompted to close Monster Truck 
Madness and restart Windows 95 in order for the display 
setting change to take effect.

NOTE: If you don't have the necessary 256-color driver, 
or if you aren't sure that your video card supports 256 
colors, contact your video card manufacturer.
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Switching Between Full-Screen and 
Windowed Modes
When you're playing Monster Truck Madness, you can play 
in either full-screen or windowed mode.

Choose full-screen mode for a smoother graphic display. 
While you are racing, the menu and taskbar are hidden.

Choose windowed mode when you need speedy access to the
menu bar and commands, the taskbar, or Microsoft 
Windows 95 desktop.

To switch between full-screen and windowed modes



Press F4.
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Reducing the Level of Detail in Graphics
Enhancing graphics detail comes at a cost: Slower 
performance. The less detail you display, the faster your 
monster truck will move.

To reduce the level of detail in graphics
1 On the Options menu, click Graphics.

2 Select the Automatic Graphics Quality check box.

3 Drag the Graphics Quality Adjuster slider to Runs 
Faster.

4 Click OK.

Monster Truck Madness automatically adjusts the 
graphics settings to make the game run faster.

{button ,AL(`speed')} Related Topics





Miscellaneous Tips for Making the Game 
Run Faster
· Limit the number of computer trucks you race against.

· Quit all other open applications before starting 
Monster Truck Madness.

· If you are in cockpit view with the rear view mirror 
displayed, hide the rear view mirror by pressing 
MINUS SIGN (-) on the numeric keypad or moving the
hat switch up on a joystick.

· For faster modem-to-modem or Internet gameplay via 
modem, upgrade your modem to a 28.8 kbps (or faster) 
modem.

· When setting up a race via an Internet connection, 
limit the total number of participants to three. If you 
want to race with a total of four players, all 
participants should connect via the same Internet 
Service Provider (ISP), such as MSN™, The Microsoft 
Network online service, or have an ISDN or T1 
connection to the Internet.

· Turn off music. On the Options menu, click Sound, and 
then clear the Play Music check box.

· Play music in mono rather than stereo. On the Options 
menu, click Sound. In the Playback Format list, click 
Mono.

· Turn off all sound effects and music. Press CTRL+M.

· Let Monster Truck Madness determine the graphics 
settings that will make the game run faster. On the 
Options menu, click Graphics, select the Automatic 
Graphics Quality check box, and then drag the 
Graphics Quality Adjuster slider to Runs Faster.

· Set the image quality to low. On the Options menu, 
click Graphics. In the Image Quality list, click Low 
(Faster).

· Set the graphics resolution to 320 x 400 or 320 x 200.
On the Options menu, click Graphics. In the Simulation
Resolution list, click one of the resolution options 
above.
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If Your Monitor Is Set to Display More 
Than 256 Colors
Monster Truck Madness runs best when your monitor is 
set to display 256 colors. If you choose to leave your 
monitor set to higher color modes, it is very likely that 
Monster Truck Madness will not run satisfactorily. 
However, if you use a 3D hardware graphics accelerator, 
you may be able to get satisfactory performance in higher 
color modes.

IMPORTANT: Print this topic before starting the 
procedure. As you follow the steps below, a dialog box 
appears which may obscure this topic. Refer to the printed
topic to finish the procedure.

To set your monitor to display 256 colors



1 Click  to display the 
Display Properties dialog box.

2 In the Color Palette list, click 256 Color.
3 Click OK.
IMPORTANT: You may be prompted to restart Windows 
95 in order for the display setting change to take effect. 
Before you restart Windows 95, press ALT+TAB to return
to Monster Truck Madness and quit the game.

NOTE: If you don't have the necessary 256-color driver, 
or if you aren't sure that your video card supports 256 
colors, contact your video card manufacturer.

{button ,AL(`MiscTips;reduce detail;switch between')} 
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If Your Screen Resolution Is 640 x 400 
and the Game Runs Slowly
Monster Truck Madness runs best when your monitor is 
set to 640 x 480 screen resolution. If you choose to have 
your monitor set to 640 x 400, it is very likely that 
Monster Truck Madness will not run satisfactorily.

NOTE: Your monitor and display adapter determine 
whether you can change your screen resolution.

IMPORTANT: Print this topic before starting the 
procedure. As you follow the steps below, a dialog box 
appears which may obscure this topic. Refer to the printed
topic to finish the procedure.

To set your monitor to 640 x 480 screen resolution



1 Click  to display the 
Display Properties dialog box.

2 Under Desktop Area, drag the slider to select the
640 x 480 resolution option.
3 Click OK and follow the instructions on the screen 
to adjust your display settings and keep the new setting.

{button ,AL(`MiscTips;reduce detail;switch between')} 
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If the Graphics Have Less Detail Than 
You Would Like
Enhancing graphics detail comes at a cost: Slow 
performance. The less detail you display, the faster your 
monster truck will move.

1 On the Options menu, click Graphics.

2 Under Graphics Details, choose a higher level of 
quality or detail for each option. 

Right-click Tip: To find out more about an option, 
place the mouse pointer over the option and click the 
right mouse button.

3 Click OK.

Experiment with different settings to find the balance
you want between speed and graphic detail.





If Your Steering Control is Too Sensitive
If you are having difficulty controlling your truck because 
your driving control's steering response seems too 
sensitive, you can adjust its sensitivity.

1 On the Options menu, click Controls.

2 Under Steering Response, drag the slider to the right 
to make the steering response less sensitive.

3 Click OK.

Test the new setting in a race. You may need to 
experiment to find the perfect steering response 
setting for your steering control and your driving 
style.

{button ,AL(`steersensitive;driving 
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If Your Steering Control is Not Sensitive 
Enough
If you are having difficulty controlling your truck because 
your driving control's steering response is not sensitive 
enough, you can adjust its sensitivity.

1 On the Options menu, click Controls.

2 Under Steering Response, drag the slider to the left 
to make your control's steering response more 
sensitive.

3 Click OK.

Test the new settings in a race. You may need to 
experiment to find the perfect steering response 
setting for your steering control and your driving 
style.

{button ,AL(`steersensitive;driving 
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If You Don't Hear Any Sound
· You may have all game sounds turned off. Click the 

Options menu. If the Mute Sound command is 
checked, click it to enable sounds.

· You may need to increase the volume. On the Options 
menu, click Sound. Drag the sound effects and music 
sliders to the right.

· Make sure your speakers or headphones are connected
properly.

· The volume may be turned down on your speakers or 
headphones.

· You may not have the latest sound driver available. 
Contact the manufacturer of your sound card to obtain
the latest sound driver.
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If the Sound Seems Clipped, or the 
Sound Effects Are Delayed
1 On the Options menu, click Sound.

2 Click Advanced.

3 If the sound is choppy or clipped, increase the number
of buffers slightly.

4 To listen to the effects of the new settings, click 
Test.

5 If the sound is still clipped, increase the buffer size 
slightly, and then click Test.

6 Continue to experiment until the sound is smooth and 
timed appropriately.

NOTE: You can restore the original sound settings by 
clicking Default.

7 To apply the new settings, click OK.

8 To close the Sound Options dialog box, click OK.
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If You Have Two Joysticks Installed on 
Your Computer
If you're a true power gamer with more than one joystick 
installed on your computer, you need to specify which one 
you will use when playing Monster Truck Madness.

NOTE: You must also designate your preferred joystick as
the primary driving control. For more information, see 
Choosing a Primary Driving Control.

IMPORTANT: Print this topic before starting the 
procedure. As you follow the steps below, a dialog box 
appears which may obscure this topic. Refer to the printed
topic to finish the procedure.

To specify which joystick you want to drive with

1 Click  to display the 
Joystick Properties dialog box.

2 In the Current Joystick list, click the joystick 
you want to use for Monster Truck Madness.
3 Click OK.

The joystick you selected remains the current joystick
for all programs until you change it again.

{button ,AL(`no joy;customjoy;calibrate;Sidewinder')} 
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If the Joystick Does Not Function 
Correctly
· You may need to calibrate the joystick. Click

 to display the Joystick 
Properties dialog box. Click Calibrate, and then follow 
the instructions on the screen.

· The joystick buttons may have been assigned 
customized functions. You can return the buttons to their 
default settings, or assign different functions to the 
buttons. For more information, see Customizing Your 
Joystick Controls.
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If the Keyboard Does Not Work as 
Expected
· You may be using the PLUS SIGN (+) and MINUS 

SIGN (-) keys on the main keyboard area. Use the 
keys on the numeric keypad instead.

· Use the arrow keys to control your truck like you 
would use a joystick. Pressing the UP ARROW key is 
like pushing a joystick forward: It accelerates your 
truck forward. Pressing the DOWN ARROW key is 
like pulling the joystick back: It applies the brakes, 
and once the truck has stopped, it reverses the truck 
(in automatic transmission only). You can easily 
customize these keyboard settings.

· The functions of the keys may have been assigned 
customized settings. You can return the keys to their 
default settings, or assign different functions to the 
keys. For more information, see Customizing Your 
Keyboard Controls.

{button ,AL(`drivingkey;drivingjoy;allkey;customjoy;custom
key;calibrate')} Related Topics





If You Use an Orchid Fahrenheit 64Pro 
PCI4 Video Card
If you run Monster Truck Madness on a computer that has 
an Orchid Fahrenheit 64Pro PCI4 video card and your 
screen resolution is set to 800 x 600 or higher, you may 
experience screen flickering when you minimize Monster 
Truck Madness. To correct the problem, follow the steps 
below.

IMPORTANT: Print this topic before starting the 
procedure. As you follow the steps below, a dialog box 
appears which may obscure this topic. Refer to the printed
topic to finish the procedure.

1 Click  to display the 
Display Properties dialog box.

2 Under Desktop Area, drag the pointer to the left 
to select 640 x 480 screen resolution.
3 Click OK.
IMPORTANT: Depending on how your system is 
configured, you may be prompted to close Monster Truck 
Madness and restart Windows 95 in order for the display 
setting change to take effect.



Earning a Class B Monster Truck Driver's 
License
Since 1995, the MTRA requires all new monster truck 
drivers to pass several tests. Passing these tests confirms 
their competency to drive monster trucks.

Earning a Class B Monster Truck Driver's license is the 
first step new drivers take on their way to earning a Class 
A Monster Truck Driver's license, which is required when 
driving in a Certified Penda Point or Purse Race Series 
event.

To earn a Class B Monster Truck Driver's license, you must 
complete a prescribed driving test in an MTRA-certified 
vehicle and in the presence of three different MTRA Class 
A drivers. The driving test includes the following:

· Cab familiarity test. You are asked to identify key 
switches, buttons, and dials in the cab, with an 
emphasis on safety and emergency features.

· Vehicle stopping, starting, and turning 
demonstration. You must complete these basic 
maneuvers.

· Driving over cars several times at different speeds. 
You must drive over cars and show that you can control
the vehicle as it completes classic monster truck 
moves.

Once you've completed your driving test, Class A drivers 
who observed you must endorse your performance by 
signing your application, which you must then send to the 
MTRA Board of Directors for approval.
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Earning a Class A Monster Truck Driver's 
License
While earning a Class B Monster Truck Driver's License is 
an accomplishment to be proud of, it's also kind of like a 
learner's permit. You can't compete in any Certified Penda 
Point or Purse Race Series event until you earn a Class A 
license.

The road to a Class A driver's license is paved with the 
following requirements:

· A Class B driver's license.

· You must execute 10 performances in an MTRA-
certified vehicle; At least one Class A driver must 
witness and sign-off on each performance. The MTRA 
rules require that you get sign-off from at least three 
different Class A drivers.

· Once you've completed the 10 performances, the 
MTRA Board of Directors evaluates your application 
and decides whether to issue the license or require 
more testing.

Once you've earned your Class A license, it is your duty to 
watch Class B drivers and evaluate their driving. And, "It 
would be a good idea to give constructive criticism." (MTRA
Official Safety Rules)
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Spectacular Crashes
Try controlling a 5-ton monster truck as it races at high 
speed. Talk about a challenging and unforgiving task! One 
false move, one tiny miscalculation, and the 10,000-plus 
pounds of rubber, steel, and fiberglass you're strapped 
into hurtles out of control. You careen and flip 
unpredictably, damaging the vehicle and everything that 
gets in its way.

The drivers on the professional monster truck tour are the 
most skilled in the world and the MTRA enforces stringent 
safety rules to protect both the drivers and the fans who 
cheer them on. But even the experts can have a bad day.

To watch the video, click the image in the left margin.

For details on monster truck safety rules, see    Monster 
Truck Safety Rules.



Great Moments in Monster Truck History
Since the first marriage of truck and giant tires in 1974, 
the sport of monster truck racing has grown by leaps and 
bounds, surpassing even the wildest hopes and dreams of 
monster truck pioneers such as BIGFOOT creator Bob 
Chandler.

Let's take a moment to reflect and look back on some 
memorable moments in monster truck history. Click the 
images in the left margin to watch videos that showcase 
the history of monster trucks.

The First Car Crush
BIGFOOT 1, the Original Monster Truck®, built in 1974, 
was originally created as a promotional vehicle for Bob and 
Marilyn Chandler's 4-wheel drive business. Its popularity 
grew quickly, and promoters began to take notice.

In 1981, in a suburban St. Louis cornfield, Bob and his crew 
conducted an experiment with BIGFOOT 1 that would 
change the world of giant trucks forever. To watch the 
first car crush and many of the earliest public car crushes, 
click the first video in the left margin.

The First Public Car Crush
Once the giggles and exclamations of amazement died 
down, Bob and the others who witnessed the first car 
crush in that suburban backyard knew they were onto 
something.

BIGFOOT crushed cars in public for the first time in April,
1982. Thousands of spectators in Jefferson City, Missouri 
(April, 1982) watched electrified as BIGFOOT crumpled 
cars, smashed windshields, and made its memorable mark on
the world of motorsports.

Racing a Paddlewheel Steamboat
As BIGFOOT's popularity and notoriety increased, the 
BIGFOOT team found other innovative ways to showcase 
their truck's unique driving capabilities.

In 1985, BIGFOOT raced head-to-head against a 
paddlewheel steamboat on the Chattahoochie River in 
Columbus, Georgia. To watch this strange amphibious 
battle, click the second video in the left margin.

Record-breaking Jump
In July, 1995 (Springfield, Missouri), BIGFOOT 11 (also 
known as Wildfoot) set an all-time distance record for a 
jump. Driver Eric Tack jumped 117 feet over crush cars and



dirt: A record that stands to this day. Although no video 
footage of this auspicious monster truck moment exists, 
Eric's attempt to repeat the feat the following day was 
captured on videotape. To watch Eric's 112-foot follow-up 
jump, click the third video in the left margin.

If the first 20 years are any indication, monster trucks will
continue to make memorable moves as they thunder their 
way into the 21st century. Crushing cars, racing riverboats, 
flying through the air: What's going to happen next?



Monster Truck Safety Rules
The Monster Truck Racing Association (MTRA), the 
governing body of the professional monster truck tour, 
enforces stringent safety rules to ensure the safety of all 
participants in a monster truck event, from the drivers and 
their crews to the thousands of fans who flock to 
fairgrounds and stadiums all over North America to catch 
monster truck action.

The most important safety requirements include:

· Remote Ignition Interrupt System (RII). All MTRA-
certified monster trucks must be equipped with an RII,
which, when activated, shuts off power to the electric 
fuel pumps and ignition system.

For official MTRA-sanctioned racing events, each truck
has an observer who controls the RII from a safe 
vantage point with an unobstructed view of the truck. 
The MTRA recommends that "a vehicle must be killed 
if it veers off the track, even if just slightly." If you 
go to monster truck events or see them on TV, you 
know that the RII system on each truck is tested 
immediately before the start of each racing heat. 
When a monster truck's engine suddenly goes silent 
just minutes before a racing heat, you know the RII is 
being tested.

· In-cab kill switch. All MTRA-certified monster trucks
must have an in-cab kill switch located within easy 
reach of the driver. The switch shuts off all power to 
the electric fuel pumps and the ignition system. The in-
cab kill switch provides built-in redundancy with the 
RII. If one system fails, there is a backup. A driver 
must demonstrate the ability to activate the kill switch
with eyes closed and while belted into the seat.

Other safety requirements include an onboard fire 
retardant system, firewalls, and stringent requirements for
driver clothing, including eye protection, neck collars, 
helmets with helmet restraints, and fire-retardant safety 
suits.

The MTRA enforces these rules in order to protect the 
lives and safety of the drivers, their crews, and their fans.



Transporting Monster Trucks
You don't see them in traffic during the morning commute 
too often, so how do monster trucks make their way from 
one racing event to another?

Their large size and lack of working headlights (Snake 
Bite's snake eyes don't count!) make it illegal to drive a 
monster truck on public roads and highways. So, monster 
trucks on the professional monster truck tour are 
transported in 18-wheel tractor-trailer rigs. Before the 
trucks are driven into the trailers, the crew strips them of 
some of their most prominent and important parts.

To view a monster truck being loaded for transport, click 
the video in the left margin.

The next time you cruise down one of America's 
interstates, keep in mind that what looks like a moving van 
ahead of you on the highway may actually be a monster 
truck's rolling home away from home.

Monster Tires: The Gripping Story
Let's face it: Its tires are a monster truck's most 
significant feature. It's hard not to notice them!

If you've ever thought about slapping a couple of monster 
tires onto your pickup and heading out on the highway, keep
in mind that it can be costly: Your average monster truck 
tire costs $1800 (U.S. dollars)!

Most trucks on the professional monster truck tour use 
Goodyear Terra tires, which are more commonly used as 
flotation tires on farming equipment. At 66 inches high and 
34 inches wide, Terra tires weigh almost one-half ton 
apiece.

BIGFOOT, the original monster truck, uses Firestone 
Monster Truck Racing Tires (similar to Firestone-patented 



experimental flotation tires formed from a 23-degree 
mold), which are custom-manufactured exclusively for 
BIGFOOT 4 x 4, Inc.

Depending on the race surface, some monster truck teams 
sculpt up to 150 pounds of rubber from the tire tread, 
essentially creating a custom tire tread cut while reducing 
the overall weight of both tire and truck.

All of this "tire-ing" discussion of treads and tires leads 
one to ask the question: If a truck with Terra tires is 
called a "monster truck," why isn't a tractor with Terra 
tires called a "monster tractor"? Something to think about 
the next time you cruise through farmland in a rally race!

Monster Truck Size Requirements
In order to be certified by the MTRA, a monster truck 
must weigh a minimum of 10,000 pounds.

Although monster trucks look like conventional stock 
vehicle bodies with humongous tires attached, their 
appearance is deceiving. Most monster truck bodies are 
hatched from molded fiberglass, which is supported by a 
steel frame.

This lighter truck body allows more emphasis on building 
strength and weight into the truck's engine and frame 
without sacrificing speed and maneuverability.

For your added reading pleasure, see the size, weight, and 
equipment summary sheets for the following trucks: Bear 
Foot, BIGFOOT 15, Boogey Van, Carolina Crusher, Grave 
Digger, Monster Patrol, Overkill, Power Wheels BIGFOOT, 
Rampage, Samson, Snake Bite, and Wildfoot.



Evolution of Monster Truck Design
Since 1974, when Bob Chandler started creating what would
become the first monster truck, monster truck design has 
evolved dramatically. From his early days of customizing a 
Ford F250 pickup, which he used for family fun and 
promotional appearances, to using an AUTOCAD computer 
program to design today's state-of-the-art monster truck, 
Bob has been a visionary. His forceful imagination has 
anticipated and continues to drive the development of a 
motorsport that captures the heart and imagination of 
between 9 and 10 million monster truck fans every year.

You can trace the evolution of monster truck design 
through its three developmental stages by following the 
development of the BIGFOOT family of monster trucks.

{button ,AL(`evolution')} Related Topics 

Stage One Monster Trucks
Bob Chandler, the inventor of monster trucks, calls the 
first three BIGFOOTs stage one monster trucks, which 
means that they were built heavy and slow, with a focus on 
maximizing their car-crushing capabilities.

BIGFOOT 1, "The Original Monster Truck®", began 
evolving into a monster truck in 1974. In 1982 in Jefferson 
City, Missouri, it became the first monster truck to ever 
crush cars in public.

BIGFOOT 2, built in the summer of 1982, was the first 
monster truck to use Firestone 23-degree, 66 x 43 x 25-
inch flotation tires.

BIGFOOT 3, built in 1983, was the first monster truck to 
perform in Japan.
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Stage Two Monster Trucks
BIGFOOTs 4, 6, and 7 are excellent examples of stage two 
monster trucks. Stage two monster trucks were built to 
crush cars, of course, but they were lighter and had more 
horsepower for racing.

BIGFOOT 4, built in 1984, was the first monster truck to 
perform a wheel-standing sled pull. The truck appeared in a
series of Ford Trucks television commercials in 1985. After
being converted to a race truck in 1988, BIGFOOT 4 
captured the 1990 championship of the Special Events 
Monster Truck Triple Crown Series.

BIGFOOT 6, built in 1986, set a record in 1987 by jumping 
over 13 cars at a Jamboree in Indianapolis, Indiana. A true 
Monster Truck Ambassador of Good Will, BIGFOOT 6 
toured extensively through England, Scotland, Ireland, 
Wales, Iceland, Thailand, and other countries before being 
sold to an English promoter.

BIGFOOT 7 was built in 1988 specifically for the filming of
the movie, Roadhouse. In the film, the truck displays all the
characteristics of a true stage two monster truck. It 
crushes cars, of course, but it also flies through the air 
and displays impressive pickup power.
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Stage Three Monster Trucks
Stage three monster trucks set the standard as monster 
trucks move into the 21st century. These performance 
racing trucks have tubular chassis, high tech suspensions, 
and lots of power. They ride smoother, and are faster and 
easier to control than any big-tired truck that came before
them. Bob Chandler's concept and ideas for the suspension 
in his stage three monster trucks are so innovative they've 
been awarded a U.S. patent, a first for monster truck 
racing.

BIGFOOT 8, built in 1989, was the first monster truck 
completely designed and blueprinted with the use of an 
AUTOCAD computer program. The truck has a unique 
nitrogen shock/cantilever suspension, which gives it about 2
feet of travel. BIGFOOT 8 dominated the older, Stage 2 
"spring" trucks, winning the 1990 Monster Truck 
Championship.

BIGFOOT 10, built in 1991, is a refinement of BIGFOOTs 8
and 9 and is the product of more than 700 hours of 
computer design work. One of the lightest trucks in the 
fleet, BIGFOOT 10 weighs in at just over 10,000 pounds.

BIGFOOT 10's engine is placed behind the driver and the 
redesigned suspension can be adjusted for up to 30 inches 
of travel. With Andy Brass behind the wheel, BIGFOOT 10 
captured the 1992 World Championship of Monster Truck 
Racing in the Penda Point Series.

BIGFOOT 11, built in 1992, is a refinement of BIGFOOT 
10, with even more suspension travel than its predecessor, 
plus the most powerful engine ever run in a BIGFOOT 
vehicle, a 572-cubic-inch Ford Hemi. With a new color 
scheme and a new name, BIGFOOT 11, formerly known as 
Wildfoot, captured the 1993 World Championship of 
Monster Truck Racing in the Penda Points Series. The same 
truck, sporting an updated BIGFOOT blue graphic scheme, 
won the 1994 Championship as well.

BIGFOOT 15, the truck you drive in Monster Truck 
Madness, is the newest truck in the BIGFOOT fleet. A 
classic stage three monster truck, BIGFOOT 15 sports a 
tubular chassis, high tech suspension, and plenty of 
horsepower.

{button ,AL(`evolution')} Related Topics



Monster Truck Fan Demographics
If the monster truck show ever comes to your hometown, 
be sure to call ahead for tickets; monster truck shows 
attract huge audiences, and you may have to fight your way 
through the crowds to get to the ticket office. Between 9 
and 10 million spectators attend live monster truck shows in
North America each year.

According to independent research, the live monster truck 
show spectator can be categorized as follows.

Monster Truck Fans and the Vehicles They Drive
Not surprisingly, 68 percent of surveyed monster truck 
show spectators drive some form of a truck, either a 
pickup, a sport utility vehicle, or a van.

A whopping 82 percent of monster truck fans perform at 
least some do-it-yourself repairs on their vehicles. 
Seventy-nine percent of them aren't fooling around; they 
even own power tools (and, no, duct tape doesn't count!).

Age and Gender Breakdown

Adults 18 and up: 61 percent of all fans; 59 percent in 
this category are male, 60 percent married

Adult age range: 
29 percent are between 18 and 24

39 percent are between 25 and 34

31 percent are between 35 and 54

Teens 13-17: 13 percent, of which 73 percent are male, 
27 percent female

Children 2-12: 26 percent, of which 63 percent are male, 
37 percent female

Television Viewing and Spectating Habits
Many monster truck fans who attend live shows know what 
they're in for because they've seen it on TV. Seventy nine 
percent of those surveyed indicated that they watch 
similar events on television.

Seventy three percent also attend one or more similar 
events each year, including monster truck racing, pulling, 
and mud racing. Eighty one percent attend another 
motorsport event at least once a year.

Consumption Habits



In one poll, 81 percent of monster truck fans responded 
that they drink beer, an average of 5.9 cans per week, in 
fact.

Their liquid intake is not limited to beer, however. They 
also consume an average of 11.34 soft drinks per week.

Some of those sodas may be consumed with fast-food 
meals. Monster truck fans visit fast food restaurants an 
average of 3.9 times per week.

They may also be buying sodas at the nearest convenience 
store. Monster truck fans shop at convenience stores an 
average of 5.6 times per week.

Household Income
The average household income for monster truck 
spectators is $39,000, with 54 percent reporting dual 
income households, 29 percent reporting single income 
households, and 17 percent reporting triple income 
households.

Sixty percent of those polled identify themselves as blue 
collar workers, while 37 percent check the white collar box.



BIGFOOT at the Movies
BIGFOOT is more than just a monster truck; it's also a 
monster movie star!

Since 1979, when BIGFOOT 1 made its movie debut in the 
classic film, Take This Job and Shove It, BIGFOOT trucks 
have filled the silver screen with dramatic entrances, car-
crushing close-ups, and spectacular stunts. They may not 
always get the girl, but monster trucks in the movies 
usually manage to steal the scene and leave the bad guys in 
the dust!

Here are some gems from BIGFOOT's celluloid history:

· BIGFOOT 2 drives over a Porsche 928 in the 1984 
film, Cannonball Run II.

· BIGFOOT 3 guns its engines in the 1985 movie, Police 
Academy 2.

· BIGFOOT 6 struts across the screen in Police 
Academy 6.

· BIGFOOT 7 was custom-built specifically for use in 
the Patrick Swayze/Sam Elliott film, Roadhouse. In one
crucial scene, which cost a half a million dollars to 
stage and was filmed with seven cameras, BIGFOOT 7 
roars through a new car showroom, annihilating four 
new cars on its way. BIGFOOT driver, Jim Kramer, a 
true professional, nailed the scene on his first 
attempt, a move the producers and directors 
appreciated highly.

· Kurt Russell and BIGFOOT 7 paired up a year later, in 
1989, for the film, Tango and Cash.

The next time you head down to your video store looking 
for a "monster" movie, skip Frankenstein and the Creature 
from the Black Lagoon, and check out one of the films 
mentioned above. Movies and monster trucks; what a great 
combination!



BIGFOOT 5: Giant Among Giants
One member of the BIGFOOT fleet stands taller than the 
rest: BIGFOOT 5, also known as the "Giant Among Giants."

Built in the summer of 1986, BIGFOOT 5 is the world's 
tallest, widest, and heaviest pickup truck. With its 10-foot-
tall Firestone Alaska Tundra tires, BIGFOOT 5 reaches a 
height of over 15 feet. 

It's hard to believe, but, in its dual-wheel configuration, 
BIGFOOT 5 is even wider than it is tall: It's 20 feet wide, 
in fact! 

With all 8 tires and wheels on, BIGFOOT 5 tips the scales 
at a whopping 38,000-plus pounds, almost four times the 
weight of the trucks currently competing on the 
professional monster truck tour.

Although it makes occasional exhibition appearances, 
BIGFOOT 5 spends most of its time on display in St. Louis, 
Missouri, USA, at the home of BIGFOOT 4 X 4, Inc., where
it is a popular photo opportunity.

BIGFOOT 5: How'd you like to see that baby coming up 
fast in your rear view mirror?



Bear Foot
Fred Shafer's three-time-USHRA (United States Hot Rod 
Association)-Monster Truck Racing-Champion Bear Foot has
made its mark on the monster truck world in unusual ways. 
The truck made an appearance on the "Knight Rider" TV 
series, in ZZ Top's music video "Sleeping Bag," and as the 
cover model for a popular children's coloring book—a claim 
no other monster truck can make.

Fred Shafer was 14 when he built his first race car. He 
assembled the racing engine and chassis himself. In 1972, 
he won the first of his many Pro Stock Eliminator 
Championships.

In 1979, he built one of the first monster trucks, and was 
the first to use the 66-inch Goodyear Terra Tires. He won 
his first USHRA monster truck    championship in 1990, 
followed by back-to-back USHRA championships in 1992 
and 1993.

In the early days of competition, Fred was often seen 
driving his truck with his two pet American black bears, 
Sugar and Spice, in the truck bed. Fans who saw the bears 
started calling the truck "Bear Foot," and the name stuck.

In addition to maintaining a dominating presence on the 
monster truck tour, Fred is also a national spokesman for 



the "Race Against Drugs" campaign. "The message to kids is
the same wherever I go," says Shafer. "I really believe you 
should give your dreams a chance to grow—Just Say No! I 
keep physically fit, don't smoke, don't drink, and watch 
what I eat. These things all help you become a winner."

Fred and the Bear Foot team have their sights set firmly 
on winning their fourth USHRA Monster Truck Racing 
Championship. "It only takes being a little faster than the 
competition," Fred says with a smile. "I'm an experienced 
driver, and when you combine that with our Dodge 
advantage, you've got a monster truck team that's tough to
beat."

Bear Foot Fast Facts
Owner/Driver Fred Shafer

Hometown Pontoon Beach, Illinois, USA

Vehicle Body Dodge Ram pickup

Frame Custom-made, tubular

Engine 572 c.i. Dodge

Horsepower 1500 @6000 rpm

Fuel System Blown, fuel-injected with alcohol

Supercharger 871, 10% Overdrive

Gauges Mopar Performance

Safety Equipment Deist

Spark Plugs Champion

Suspension Nitrogen shocks, 30 inches wheel 
travel

Wheels Custom-made steel

Frame Custom-made, tubular

Axles ZF Axles with planetary gears in ends

Height 10 feet

Weight 10,000 pounds

Tires Goodyear Terra Tires, size 66 x 43 x 
25



BIGFOOT 15
BIGFOOT 15 is the latest incarnation of the "Original 
Monster Truck®." Designed and owned by monster truck 
forefather Bob Chandler, BIGFOOT dominates the Penda 
Point Series, winning drag races and the hearts of fans all 
over North America.

With its combination of trucks that includes BIGFOOT, 
Wildfoot, and Power Wheels BIGFOOT, Team BIGFOOT 
has won five Monster Truck Racing Championships (one 
TNT championship, and four Penda Championships).

Like many successful professional monster truck drivers, 
Eric Meagher got his start as a BIGFOOT crew member, 
eventually working his way up to driver.

What's Eric's favorite thing about racing monster trucks?  
"Size. Power. Speed. Jumps. What could be better? It's an 
all-American sport!" Eric's fastest recorded drag time is 
4.83 seconds.

Eric's 2 most memorable monster truck moments: "My first
victory, which came on my birthday, May 11, 1991, in 
Washington State"; and, in New York, 1995, "My first big 
crash, and my first rollover in BIGFOOT 15."



Eric's words of advice to Monster Truck Madness drivers: 
"Do not be afraid or intimidated at any time. Go for the 
win! Know that you have what it takes to win!"

BIGFOOT Fast Facts
Owners Bob and Marilyn Chandler

Driver Eric Meagher

Hometown Fallston, Maryland, USA

Vehicle 1997 F150 Fiberglass Ford pickup 
body and a Deflecta-Shield cab 
extender and sunvisor

Frame Computer-aided design complete 
tubular frame and cage

Engine 572 c.i. Ford with a 871 BDS blower, 
fuel injection, Isky cam, Wiseco 
pistons, Total Seal piston rings, MSD 
ignition, K&N air filter, Mr. Gasket 
gaskets, AeroQuip hoses and fittings, 
RJS fire system, Clevite 77 engine 
bearings, ARP fasteners, Milodon oil 
pan, and Racor oil filter
Powered by Jaz fuel cell

Height 10 feet

Width 11 feet, 9 inches

Weight 10,700 pounds

Transmission Ford C6 Automatic with Alabama 
bands, Hurst shifter, TCI race 
converter, and an aluminum transfer 
case with quick change gears

Tires Firestone Monster Truck Racing Tires
(Firestone-patented experimental 23-
degree flotation tires), size 66 x 43 x
25

Shocks 8 Trailmaster Long Travel nitrogen 
charged shocks

Axles ZF axles with internal wet disc brakes
and planetaries



Boogey Van
In a motorsport filled with colorful paintjobs and 
impressive fiberglass appendages, the Boogey Van stands 
out. What makes it so special?

"It's the only van on the circuit, and it's driven by a 
woman," says owner/driver Pamela Vaters. "The Boogey Van
doesn't run right when men drive it!"

A pioneer in the world of monster truck racing, Pamela got 
her start in 1984 working as crew chief for Black Stallion, 
her husband Michael Vaters's monster truck. In 1992, 
after eight years of traveling with her husband, she 
decided the time was right to start driving.

It should come as no surprise that Pam's favorite opponent 
is Black Stallion 2000, driven by her husband.

Her most memorable monster truck moment: "My first 
points race. I qualified in sixth position. In my first round, 
I took BIGFOOT out of the competition!"

Pam's words of advice to women who are interested in 
pursuing monster truck racing as a career: "First, you have 
to have an open mind because all your competitors are men. 
Second, if it's your dream, I say chase it! If you don't, 
you'll never forgive yourself."



Pam also has some words of advice for Monster Truck 
Madness drivers of any gender: "Always remember: When 
you're behind the wheel for a drag race, aim straight. If 
you lift, you LOSE!"

Boogey Van Fast Facts
Owners Pamela and Michael Vaters

Driver Pamela Vaters

Hometown Hagerstown, Maryland, USA

Vehicle Body 1995 Ford Aerostar van

Engine 572 c.i. Ford SVO engine

Frame Custom-built chassis by Michael 
Vaters

Transmission C-6 transmission with a 24-inch drop 
ProFab

Axles P-106 with Rockwell planetaries

Shocks Custom-built (with 36 inches of 
travel) by Michael Vaters

Height 12 feet

Width 12 feet, 4 inches

Weight 10,232 pounds (including the driver!)

Tires Goodyear Terra tires, size 66 x 43 x 
25

Sponsors M30 Hand Cleaner, KC Hilites, Valvco 
Cincinnati, House of Kolor Paints



Carolina Crusher
The first time he saw a monster truck in action in 1983, 
Gary Porter knew he had to have one. "The way the trucks 
crushed cars, and the way people responded, made a big 
impression on me," Gary says. "Two years later, we built the
first Carolina Crusher."

Always a potent force on the professional monster truck 
tour, Gary and Carolina Crusher won the 1991 Penda 
Monster Truck Racing Championship. Gary's fastest 
recorded drag time is 4.92 seconds, and his favorite 
opponent is a fellow Tarheel, Grave Digger driver Dennis 
Anderson. When he's not behind the wheel of the Crusher, 
Gary drives a Chevy 1500 extended cab pickup, or a Z28.

Gary's worst crash came in Oklahoma City, Oklahoma, in 
1992: "It was a wild ride. I had to walk away from racing 
for awhile to get myself back together. The truck was 
totally destroyed."

Fortunately for monster truck fans everywhere, Gary 
recovered from that crash, rebuilt Carolina Crusher, and 
returned to racing. His words of advice for Monster Truck 
Madness racers: "Fasten your seatbelt and hold on! This 
should be the best monster truck ride you'll ever get, 
unless you join me in the cab of the real Carolina Crusher. 



Good luck!"

Carolina Crusher Fast Facts
Owner/Driver Gary Porter

Hometown Wadesboro, North Carolina, USA

Vehicle Body 1995 Chevy

Engine 557 c.i. Rodeck engine

Transmission Turbo 400 Neal Chance Racing 
Converters

Axles Rockwells 106

Shocks 26-inch nitrogen

Height 11 feet, 4 inches

Width 12 feet, 4 inches

Weight 10,000 pounds

Tires Goodyear Terra tires, size 66 x 43 x 
25

Sponsors Big A Auto Parts, Porter's 4 x 4 
Center, Chance Racing Converters, 
Valco Cincinnati Racing



Grave Digger
"Anything but first is dead last"
With a birthplace called Kill Devil Hills (North Carolina) and
a paint job that can chill the heart of even the toughest 
competitor, it's no surprise that Grave Digger's slogan is: 
"Burying the competition since 1981…"

How did Grave Digger get its name?
In 1981, when Dennis Anderson was creating a "monster" 
from dead and discarded vehicle parts to compete in a Kill 
Devil Hills mud-bog contest, the other competitors laughed 
in his face, boasting that their new big-buck trucks would 
kick his butt.

The legend of Grave Digger was born in Dennis's response 
to his opponents: "I'll take this old junk, and dig your 
grave," a promise he and Grave Digger have been keeping 
since 1981.

Grave Digger Gets a Facelift
In 1985, Dennis made a fateful appointment with Fred 
Bumann, an artist and auto painter who took 18 hours to 
create Grave Digger's now-famous paint job, complete with 
green flamework.

In 1988, after several successful seasons racing on the 



MTRA tour, Dennis recognized that Grave Digger's all-steel
body and heavy suspension were a handicap. With the 
emphasis for monster trucks moving from crushing 
capability to speed, Grave Digger needed a redesign to stay
competitive.

After Dennis worked closely with a specialty fiberglass 
manufacturer, Grave Digger was reborn with a light-weight 
all-fiberglass body patterned after a 1950 Chevrolet panel 
van. Its unmistakable sinister paint job and new lighter 
body make Grave Digger the ultimate modern day monster.

Of Course Grave Digger Has a Fan Club…
Dennis Anderson's distinctive monster truck is one of the 
best known and best loved on the monster truck tour. 

Grave Digger has a fan club.

To join the Grave Digger Fan Club, write:

Grave Digger 4 x 4, Inc.
P.O. Box 250
Poplar Branch, NC 27965
USA
1-800-4 DGR FANS

…And a Web Site
http://www.webcom.com/shownet/gravedig/welcome.html

Grave Digger Fast Facts
Owners Dennis and Julie Anderson

Driver Dennis Anderson

Hometown Poplar Branch, North Carolina, USA

Vehicle Body 1950 Chevrolet Panel Wagon with a 
fiberglass body and a custom Cro-moly
tube steel frame

Engine Keith Black 540 c.i. Chevrolet Big 
Block motor with blower and alcohol 
injection

Horsepower Approximately 1500 h.p.

Transmission Modified Turbo 400

Axles Custom-built planetaries

Shocks Kuster Coil-Over Monster Shocks 
with 18 inches of travel

Height 10 feet, 9 inches

Width 12 feet

Weight 10,000 pounds

Tires Goodyear Terra tires, size 66 x 43 x 
25

Sponsors Autometer, Creative Glass, Crower, 
Citgo, DuPont, Goodyear, Hooker 



Headers, Racer Components, Inc., TCI
Automotive, Trailmaster Suspension, 
Russell



Monster Patrol
When Monster Patrol is on the beat, you know that fast 
times and tough competition can't be far away.

With its distinctive wing spoilers and eye-catching police 
lights, Monster Patrol is one monster truck that looks as if 
it could really run you down.

Paul Shafer, the owner/driver who started racing Monster 
Patrol on the professional tour in 1993, is no stranger to 
motorsports.

From a boyhood spent racing slot cars, to stock car racing 
in his 20's, and mud racing in his 30's, Paul brings a wealth 
of experience to the sport of monster truck racing.

How did Monster Patrol get its name? Paul's first mud 
buggy was named "Mud Patrol," so when it came time to pick
a name for his monster truck, "Monster Patrol" seemed like
the natural choice.

Paul's most memorable monster truck moment: "Monster 
Patrol's first victory, in Pontiac, Michigan in 1994. It was 
televised live, and I defeated the reigning world champion, 
Bear Foot. Even today, Bear Foot is my favorite opponent."

Monster Patrol Fast Facts
Owner Paul Shafer

Hometown Portage, Indiana, USA

Personal Vehicle 1995 Chevy ¾-ton truck

Fastest Drag Time 5.02 seconds

Favorite Opponent Bear Foot

Vehicle Body 1995 Chevrolet

Height 12 feet, 8 inches

Width 12 feet

Weight 10,000 pounds

Engine 575 c.i. Chevy engine

Transmission 400 Chevy Turbo Trans

Tires Goodyear, size 66 x 43 x 25

Shocks Steve Combs

Suspension Nitrogen gas shocks (no springs)

Axles ZF Axles

Sponsors Red Baron Truck Washes, Inc., Fel-
Pro Performance Gaskets, Van Senus 
Auto Parts, K-C Lights, Mile Marker 
Wrench, Lund Truck Accessories, 
Paul's Auto Yard, Inc.



Overkill
Overkill, the monster pride and joy of Fort Wayne, Indiana,
is the perfect name for Kirk Dabney's monster truck. 
Reflecting on how the truck earned its name, Kirk 
comments: "We spent so many hours and so much time 
building this truck that we could have settled for less, but 
we had to go for overkill." It's clear that settling for less 
is not on Kirk's (or Overkill's) agenda.

Like many monster truck racers, Kirk got his monster truck
start working on 4 x 4 trucks. He built his own shop, 
worked on 4 x 4's for a living, and built his first monster 
truck as a promotion for his business. He started monster 
truck racing in 1984. When he's not behind the wheel of 
Overkill, Kirk doesn't stray too far vehicle-wise; he drives 
a Ford 4 x 4 pickup with lift kits and tires. One of the 
things he loves best about monster truck racing is traveling
around the country meeting and talking with fans who are 
also into 4 x 4's.

Overkill is one of the few trucks on the professional 
monster truck tour that weighs in at 9,800 pounds, 200 
pounds shy of the MTRA-required minimum 10,000 pounds. 
In preparation for competition racing, Kirk and crew add 
200 pounds of load weights to the truck to meet MTRA 



rules.

Kirk has some pragmatic advice for Monster Truck Madness
racers: "Practice. Practice. Practice. Learn to shift at the 
correct time. Stay after the throttle, even when your 
truck is in a power slide. Learn when to ease up on the gas. 
Good luck!"

Overkill Fast Facts
Owner/Driver Kirk Dabney

Hometown Fort Wayne, Indiana, USA

Favorite Opponent Boogey Van

Vehicle Body Ford F350 Super Cab pickup 
truck

Frame Custom tubular design

Engine 575 c.i. Stephens & Hull racing 
engine

Transmission C-6 by Russ Moore Transmissions

Axles Rockwell 106's with 115 ends

Shocks Kuster nitrogen racing shocks

Suspension 36-inch 4-link swing-arm 
suspension

Height 11 feet

Width 11 feet, 5 inches

Weight 9,800 pounds (before adding load
weights)

Tires Goodyear Terra tires, size 66 x 
43 x 25

Sponsors Ford Motor Company, Ramsey 
Winch, Trailmaster, Flex-Lite 
Fans, Fort Wayne Clutch, Russ 
Moore Transmission, Cooks Body 
Shop, Knnack Manufacturing



Power Wheels BIGFOOT
With two-time MTRA Driver of the Year, Dan Runte, 
behind the wheel, Power Wheels BIGFOOT is one of the 
most successful and one of the most intimidating trucks on 
the professional tour.

This truck won the 1995 Special Events Penda Point Series. 
Dan and Power Wheels BIGFOOT set a record that year by
winning 8 of 15 races in 1995.

With its combination of trucks that includes Power Wheels 
BIGFOOT, BIGFOOT, and Wildfoot, Team BIGFOOT has 
won five Monster Truck Racing Championships (one TNT 
championship, and four Penda Championships).

Dan got his start in motorsports working on a pulling truck 
crew. He enjoyed watching the monster truck competitions,
and joined the BIGFOOT crew in 1989.

He graduated to BIGFOOT driver in 1991, and was named 
the MTRA Driver of the Year in 1993 and 1995.

Dan's fastest recorded drag time is 4.77 seconds, and his 
favorite opponent is Gary Porter's Carolina Crusher. His 
fondest monster truck memory: "Touring Australia for 3 
months in 1991. The crowd response was awesome!"

What does Dan drive when he's not behind the wheel of 



Power Wheels BIGFOOT? A Ford Mustang GT.

Power Wheels BIGFOOT Fast Facts
Owners Bob and Marilyn Chandler

Driver Dan Runte

Hometown Freeport, Illinois, USA

Vehicle Body 1997 Ford F150 fiberglass pickup 
body with a Deflecta-Shield cab 
extender and visor

Engine 572 Ford Hemi with an 871 BDS 
blower, fuel injection, Isky cam, 
Wiseco pistons, Total Seal piston 
rings, MSD ignition, K&N air filter, 
Mr. Gasket gaskets, AeroQuip hoses 
and fittings, RJS fire system, Clevite 
77 engine bearings, ARP fasteners, 
Milodon oil pan, and Racor oil filter

Frame Custom-built tubular chassis

Height 10 feet, 6 inches

Width 11 feet, 8 inches

Weight 10,200 pounds

Transmission Ford C6 Automatic with Alabama 
bands, Hurst shifter, TCI race 
converter, and an aluminum transfer 
case with quick change gears

Tires Firestone Monster Truck Racing Tires
(Firestone-patented experimental 23-
degree flotation tires), size 66 x 43 x
25

Shocks Eight Trailmaster Long Travel 
nitrogen charged shocks

Axles ZF axles with internal wet disc brakes
and planetaries



Rampage
When driver Todd Frolik inched his monster truck, 
Rampage, up to the starting line for his first professional 
drag race heat in 1994, he knew he was facing some of the 
best trucks on the tour, but he took his own advice, "Don't 
be afraid to stay in the throttle and enjoy the ride," and 
rode it all the way to the winner's circle.

Todd recalls the race: "It was my first time ever driving! I 
won the whole race. First round was RoboShark, second 
round was Snake Bite, third was Grave Digger. Then, in the 
finals, I beat BIGFOOT!"

Todd loves monster truck racing because "it's exciting and 
unpredictable, kind of like the kids who love monster 
trucks." What's his favorite thing about racing monster 
trucks? "The times in a drag race when you can pick up the 
front wheels off the starting line and carry them all the 
way to the second set of cars!"

When he's not on a "rampage" with his monster truck, Todd
drives a 1995 Dodge Dakota. His fastest recorded drag 
time is 4.68 seconds, and his favorite opponent is fellow 
Dodge monster, Bear Foot.

Rampage Fast Facts



Owner Fred Shafer

Driver Todd Frolik

Hometown Pontoon Beach, Illinois, USA

Vehicle Body 1996 Dodge Ram pickup

Engine 572 c.i. Dodge Hemi

Transmission 3-speed Lenco transmission

Axles Rockwell 106's

Shocks Custom nitrogen gas shocks by Bear 
Foot, Inc.

Height 11 feet

Width 12 feet, 8 inches

Weight 10,500 pounds

Tires Goodyear Terra tires, size 66 x 43 x 
25

Sponsors Dodge Motorsports, Viper Auto 
Security, Mopar Performance, Mopar 
Express Lube, Goodyear, RCI Safety 
Equipment, M-30, "Race Against 
Drugs"



Samson
With its brawny build and patriotic paint job, Samson is a 
monster truck that looks like it could star in its own 
exercise video.

Active on the professional monster truck tour since 1994, 
Samson and driver/owner Dan Patrick made a memorable 
mark on the pages of monster truck history soon after 
they started competing.

In July 1994, at the Summer Nationals in Bloomsburg, 
Pennsylvania, Samson won its first Penda Point Series 
event, beating out the likes of Snake Bite, BIGFOOT Power
Wheels, and BIGFOOT itself (twice!). The victory over the 
BIGFOOT trucks was particularly sweet for Dan, who 
started his monster truck career building race trucks for 
BIGFOOT 4 x 4, Inc., before heading out on his own to 
make his Samson dream a reality.

On the way to this sweet series victory, Samson became 
the first monster truck to break the 5-second mark in a 
drag race heat, posting a time of 4.98.

Samson Fast Facts
Owner Dan Patrick

Hometown Kingston, Ohio, USA



Personal Vehicle 1991 Chevy S-10 Blazer

Fastest Drag Time 4.98 seconds

Favorite Opponent BIGFOOT

Vehicle Body 1995 Chevrolet

Engine 556 Keith Black engine

Transmission 4-speed Lenco Racing 
transmission

Tires Goodyear Terra tires, size 66 x 
44 x 25

Shocks 20-inch nitrogen-charged shocks

Axles F-106 Rockwell Centers, Clark 
Planetaries

Sponsors Boc Gases, P + R Machines of 
Lakewood, Indiana, KC Hi-Lites, 
M-30 Hand Cleaner, Race Rock, 
Champion Spark Plugs, Jet-Hot 
Coatings

Height 10 feet

Width 11 feet, 9 inches

Weight 10,420 pounds



Snake Bite
With its smoking fangs and distinctive snake eye lights, 
Snake Bite is one of the most intimidating trucks on the 
monster truck tour.

Colt Cobra, the mysterious masked man who pilots Snake 
Bite, is a big part of that intimidation factor. Where did 
this enigmatic, ruthless competitor come from?

His origin and background are cloudy, but unconfirmed 
rumors suggest that Cobra may be a disgruntled former 
BIGFOOT driver! Perhaps, or maybe a driver who was 
forced to retire from the sport and is now back on the tour
with vengeance on his mind.

True to Snake Bite's reptilian style and appearance, the 
driver, when questioned about his background, provides only
slippery responses. He is more forthcoming, however, when 
questioned about monster truck racing.

Colt Cobra's most memorable monster truck moment: "The 
first time I stomped 'Big Blue' into the dirt in Canfield, 
Ohio, July, 1992."

Words of advice to Monster Truck Madness drivers: "Drive
your own race. Concentrate and don't be afraid to push it 
to the limit and beyond."



How did Snake Bite get its name? Cobra's response is 
brief, but chilling: "The Snake inflicts a deadly bite, 
especially on the Foot!"

Snake Bite Fast Facts
Owner/Driver Colt Cobra

Hometown Cobra Creek, Colorado, USA

Vehicle Body Custom Fiberglass pickup body, 
fabricated by GTS Fiberglass, with 
Snakeskin automotive paint

Chassis Custom Snakesteel frame with a 
Cobra racing seat

Engine 572 c.i.d. Battlesnake Ford engine 
with 871 Viperod blower, A.S.P.    fuel 
injection, Sidewinder ignition, Mr. 
Slither gaskets, Big Boa air and oil 
filters

Transmission Snake-A-Zoid "Snakeamatic" 
automatic transmission with Hiss 
shifter, Torque-tongued converter, 
Python "Death Bite" transfer case 
with quick change gears

Height 10 feet

Width 11 feet, 9 inches

Weight 10,000 pounds

Tires Hissteria "Super Slither" flotation 
tires, size 66 x 43 x 25

Suspension SNAKE MASTER racing shocks, 
Rattleflex springs

Axles Custom-designed by Race-Nake



Wildfoot
Since its debut in Las Vegas in 1992, Wildfoot has made its
mark repeatedly in the monster truck record books. In 
1993, Wildfoot won the World Championship of Monster 
Truck Racing in the Special Events Penda Point Series. In 
the same year, Wildfoot was named MTRA's Truck of the 
Year.

With its combination of trucks that includes Wildfoot, 
BIGFOOT, and Power Wheels BIGFOOT, Team BIGFOOT 
has won five Monster Truck Racing Championships (one 
TNT championship, and four Penda Championships).

In July 1995 in Springfield, Missouri, driver Eric Tack and 
Wildfoot, then known as BIGFOOT 11, set a world record 
for long distance monster truck jumping, with a leap of 117 
feet, a record that stands to this day.

Eric got his start in the motorsports world at the age of 
14, competing in motocross and mudracing events. He 
worked his way up in the BIGFOOT organization after 
meeting and talking with BIGFOOT drivers and crews.

Aside from his record-setting jump, Eric has another 
favorite monster truck moment: "August 14, 1994, 
Jannetville, Ontario, Canada—the first time I rolled over. 
And I walked away unscathed."



Eric's words of advice to Monster Truck Madness drivers: 
"Push yourself to the limit!"

Wildfoot Fast Facts
Owners Bob and Marilyn Chandler

Driver Eric Tack

Hometown Butler, Pennsylvania, USA

Vehicle Body 1996 F250 Fiberglass Ford pickup 
body, with a Deflecta-Shield cab 
extender and sunvisor

Frame Computer-aided design complete 
tubular frame and cage

Engine 572 c.i. Ford with a 871 BDS blower, 
fuel injection, Isky cam, Wiseco 
pistons, Total Seal piston rings, MSD 
ignition, K&N air filter, Mr. Gasket 
gaskets, AeroQuip hoses and fittings, 
RJS fire system, Clevite 77 engine 
bearings, ARP fasteners, Milodon oil 
pan, and Racor oil filter

Transmission Ford C-6 with TCI race converter, 
Alabama Bands, and Hurst shifter, 
and an aluminum transfer case with 
quick change gears

Axles ZF Axles with internal wet brakes and
planetaries

Shocks 8 Nitrogen-charged Trailmaster 
shocks

Height 10 feet

Width 11 feet, 9 inches

Weight 10,000 pounds

Tires Firestone Monster Truck Racing Tires
(Firestone-patented experimental 23-
degree flotation tires), size 66 x 43 x
25



Auto Brake

A game cheat that applies the brakes for you so that you can gun it more aggressively and not worry about 
applying the brakes correctly. This cheat works best when you're driving with automatic transmission. When 
you sign in as a rookie in Monster Truck Madness, Auto Brake is automatically enabled, but you can turn it on or
off regardless of the skill level you assign yourself.



Auto Brake & Throttle 

A game cheat that accelerates your truck to its optimal speed for any situation you may encounter during a 
race and also applies the brakes wisely. This cheat works best when you're driving with automatic transmission.



Auto Shift

Auto Shift lets you floor it without having to worry about shifting gears. Keep in mind, though, that driving 
with an automatic transmission will diminish your truck's get-up-and-go; if the competition uses manual 
transmission, they may have an acceleration advantage.



Automatic Race Camera View

This view automatically switches among a variety of exciting race views from the perspective of the current 
truck.



Automatic Staging

A game cheat that prestages and stages your truck so that you arrive in legal position at the drag race 
starting line. To have Monster Truck Madness stage for you, press S, and then hit the gas when the light goes 
to green!



kbps (Kilobits Per Second)

A measurement of modem speed. A 14.4 modem can send data at a rate of 14,400 kbps, while a 28.8 modem can
send data at a rate of 28,800 kbps.



Certified Penda Point Series

The official racing series for monster trucks. A point series is a group of several racing events in which 
competitors earn points according to how they place in each event. The Penda Point Series for monster trucks 
operates on a yearly basis: The total points awarded to each monster truck in a minimum of 15 racing events 
each year are tallied at year-end to determine the final winner.



Cockpit

The cab of your monster truck. When you're in cockpit view, your view is from the driver's seat of the truck.



Down Shift

To shift a monster truck into a lower gear, for example, shifting from third gear to second gear or from first 
gear to neutral.



Host

In multiplayer racing, the host controls who participates, assigns the skill level of all participants, and what 
kind of race everyone competes in.



Internet Protocol (IP) Address

A series of numbers assigned to each individual computer connected to the Internet to distinguish it from 
other computers on the Internet.



J-Style Drag Track

A type of drag track that features a straightaway followed by a tight turn before you hit the crush car ramps 
and the finish line.



LAN (Local Area Network)

A data communications network, which is geographically limited (typically to less than a 1-mile radius), allowing 
easy interconnection of computers within adjacent buildings. (From the Free On-Line Dictionary of Computing)



Minimize

An action that shrinks the game window and adds it to the Windows 95 taskbar. To minimize the game, click 
the small button in the upper-right corner of the screen. The button is labeled with a small dash or hyphen 
character.



Monster Truck Racing Association (MTRA)

The governing body of the professional monster truck tour. MTRA emphasizes training, licensing, safety, and 
emergency preparedness to ensure the safety of both participants and spectators at all MTRA-sponsored 
events.



Penda Point System

The official monster truck racing scoring system used by the Monster Truck Racing Association (MTRA).



Planetary Gear Reduction Axles

An axle system used by many professional monster trucks. By increasing the gear reduction at the hub (the 
wheel end of the axle), planetary gear reduction axles allow the use of a smaller diameter axle. A straight 
nonplanetary axle on an early Stage 1 monster truck, like BIGFOOT 1, measures 3 inches in diameter. A 
planetary axle, on the other hand, measures 1.25 inches. The smaller axle saves weight, often an important 
factor in monster truck racing, and is also easier to build, maintain, and repair than a nonplanetary axle. 



PRNDL Gear Indicator

The small rectangle in the lower center of your screen in all racing views that displays the truck's current gear
position. The indicator actually displays "PRN123" (which isn't as easy to pronounce as "PRNDL"). "P" stands for
Park, "R" stands for Reverse, "N" stands for Neutral, and "1," "2," and "3" stand for each of the three forward
gears. "PRNDL" is a term used by gearheads and driving instructors to describe the indicator.



Shift Indicator Light

The small light perched on the tachometer in cockpit view. The shift indicator lights up when the engine revs 
to 6500 rpms, signaling you to change gears when you're driving with manual transmission.



Staging
The process by which you inch your truck forward slowly to light up the prestage and stage lights and position 
your truck legally in front of the starting line. To have Monster Truck Madness stage for you, press S.



Tachometer

A dashboard gauge that displays the number of rpms (revolutions per minute) your truck's engine is producing. 
When you're driving a monster truck with manual transmission, the optimal time to shift is when the 
tachometer indicates that the engine is revving to 6500 rpms. Beyond 6500 rpms, you aren't using your engine 
efficiently.



Taskbar

The bar on your desktop that has the Windows 95 Start button on it. Buttons representing running programs 
appear on this bar. If the taskbar is not visible, press CTRL+ESC.



Travel

The distance that a shock will compress before it achieves its maximum capacity.



Understeer

A term used to describe the behavior of a truck while cornering. A truck with understeer has the unfortunate 
tendency to want to go straight in a corner. Understeer can also be caused by giving the truck too much gas as 
you approach a turn. The challenge of understeer is finding the perfect balance between high speed and 
controlled cornering.



Up Shift

To shift a monster truck into a higher gear, for example, shifting from first gear to second gear.



URL (Universal Resource Locator)

The address to an object, document, or page on the Internet.



WinSock IPX

IPX (Internetwork Packet Exchange) is Novell's routing protocol. It is one of the most common routing 
methods used to transmit traffic on a LAN (Local Area Network) and the Internet. (From The Free On-line 
Dictionary of Computing)



WinSock TCP

The TCP (Transmission Control Protocol) is a common and reliable protocol on LANs (Local Area Network) and 
the Internet. TCP is built on top of Internet Protocol (IP) and is nearly always seen as TCP/IP. (From The Free
On-line Dictionary of Computing)



Click this and then click an item on the screen for information about that item.



Click this to shrink the Monster Truck Madness window. To restore Monster Truck Madness, click its button 
on the Windows 95 taskbar.



Shallow cut is highly recommended for hard-packed surfaces. This cut provides superior grip and handling and 
minimal rolling resistance on hard surfaces, but offers very little traction on soft surfaces. 



Medium cut is recommended for rally and circuit races, where you encounter a wide range of surfaces, from 
mud and water to paved roads and dirt tracks. This cut provides some measure of traction and some rolling 
resistance on hard surfaces, and also provides some traction on soft surfaces. 



This aggressive cut provides a lot of traction in mud, snow, and water, but it has a high rolling resistance on 
hard surfaces and minimal grip on asphalt and concrete. Deep cut is especially recommended for rally races. In 
rally races, you have the freedom to explore the countryside where you might encounter a wide range of 
surfaces and challenges, from mountainsides to mud bogs to rivers and rocks.



Soft suspension provides maximum shock absorption from large bumps or jumps. Soft suspension is highly 
recommended for rally races, which often involve crossing large ditches and navigating off-road obstacles. One
warning note: Since soft suspension tends to absorb your truck's acceleration, you are more susceptible to 
rolling over during fast cornering. 



Medium suspension provides a happy medium between the handling and response characteristics of the soft 
and hard suspension options. With medium suspension, you get a fair amount of shock absorption combined with
some level of cornering capability.



Hard suspension provides almost no shock absorption whatsoever, which means that both molehills and 
mountains can send your truck flying in the air. Because it transfers power very efficiently to the ground, hard
suspension is highly recommended for situations where you need superior cornering capability on smooth, hard 
surfaces. One warning note: They don't call hard suspension the "kidney kicker" for nothing. 



Drag the slider to the right if you want to be able to gain speed faster but with a slower top-end speed; 
settings toward the right of the slider are good for twisty tracks with short straightaways.

Drag the slider to the left if you’re racing on a track with long straightaways and fast turns, where you can 
keep your truck speed at a maximum almost all the time and not worry about acceleration.



Type your name here, or click the arrow, and then click a name from the list of previously registered drivers. 
If you select a name from the list, you also get the skill level associated with that driver's last race and the 
truck that driver last drove.



Click the arrow to display the list of skill levels, and then click the one you want. The skill level influences the 
aggressiveness and driving skill of your computer opponents. As a rookie, you'll get staging help for drag races,
and your opponents may cut you a little slack. Intermediate and professional drivers, on the other hand, can 
expect no mercy!



Click this to start your Internet browser and visit the awesome Monster Truck Web Stop, where you can 
download movies and pictures and get the inside scoop on playing the game.



Click this for help on all aspects of playing the game and for fun videos, facts, and trivia on the exciting world 
of monster trucks.



Click this to go to the screen where you select a truck and the type of race: Drag, circuit, rally, or tournament.



Click this to host or join a multiplayer game over a LAN (Local Area Network), modem, or the Internet.



Click this to get a glimpse of the fun and excitement that await you at the starting line.



Click the arrow to display the list of available trucks, and then click the one you want to drive.



Click this to select a drag race in which you hurtle over crush cars on your way to the finish line.



Click this to select a circuit race. The closed-loop tracks feature challenging surprises; you'd better be 
prepared to react quickly!



Click this to select a rally race. These are point-to-point races, in which you must pass through race 
checkpoints on your way to victory. Instead of driving on a well-defined track, you are free to blaze your own 
trail. Watch out, though; you won't win the race if you miss even one checkpoint!



Click this to select a tournament to race. A tournament is made up of several races. The races can be drags, 
circuits, and rallies.



Lists the trucks you can add to the race. 



Lists the trucks in the race. Your driver name appears in parentheses next to the truck you selected on the 
Races screen.



Click this to add to the race the truck that is highlighted in the Available Trucks list.



Click this to remove from the race the truck that is highlighted in the Competing Trucks list.



Click this to fine-tune your truck in the garage, where you can make adjustments to your tire tread cut, 
suspension, and transfer gear ratios.



Click this to read a description of the track you selected. For circuits and rallies, a map is also included.



Click this to return to the previous screen.



Click this to head to the drag race track. You're first up for a qualifying run, in which you race alone against 
the clock to determine your place in the draw.



Lists the straight and J-style drag race tracks you can choose from. J-style tracks, which feature a 
straightaway followed by a turn, are listed with a "J" in parentheses.



Click this to see valuable tips on maximizing your drag race performance.



Click this to head to the circuit race starting line. Watch for the green light, and don't forget to glare 
menacingly at your opponents!



Click this to see valuable tips on maximizing your circuit race performance.



Lists the circuit race tracks you can choose from. Each closed-loop course offers unique challenges. Try 'em 
all, and don't forget to hit all your checkpoints!



Displays the number of laps for the selected circuit race. Click the arrows to change the number of laps. You 
can have up to 20 laps.



Lists the rallies you can choose from. In a rally race, you drive from point to point, racing through diverse 
terrain. Follow the track, or find your checkpoints by using the directional finder (press F to display it). To win
or place, you've got to pass through every checkpoint, in order.



Click this to see valuable strategy tips for maximizing your rally race performance.



Click this to head to the rally race starting line, where you can intimidate your opponents and psyche yourself 
up for the challenge that awaits you.



Click this to read a description and see a map of the rally race you selected.



Lists the tournaments you can choose from. Tournaments can include drags, rallies, and circuits.



Click this to see valuable strategy tips on competing in a tournament.



Click this to head to the starting line for the first race in the tournament.



Click this to create a your own (custom) tournament, in which you specify the events and the race order.



To base a tournament on an existing tournament, click the arrow, and then click the one you want to use as the 
basis. To create a tournament from scratch, first click New before typing the name here.



Type a brief description of the tournament. Include enough detail to make this custom tournament stand out in
your memory! For example, you may want to list the race events.



Lists all the possible racing events you can include in a tournament. Click an event that you want to add to the 
tournament.



Click this to add to the tournament the racing event that is highlighted in the Events list.



Click this to remove from the tournament the racing event that is highlighted in the Selected Events list.



Click this to delete the tournament that is highlighted in the Name of Tournament list.



Click this to save the tournament along with any changes you have made.



Lists the selected tournament's racing events in the order they will be raced. 



If a circuit race is highlighted in the Selected Events list, this box displays the number of laps in the race. 
Click the arrows to change the number of laps for the race. You can have up to 20 laps.



Click this to return to the Tournament screen, where you select which tournament to race, which truck to race
against, and go to the starting line of the first event. You can also go to the garage to fine-tune your truck.



Click this to see a description of the race event that is highlighted in the Events list.



Click this for tips on custom tournaments.



Click this to create a new custom tournament from scratch.



Click this to switch to a full screen view of the race action. To return to the Instant Replay screen, press 
ESC.



Lists camera views you can use to watch the instant replay. These are the same camera views you can access 
while you're racing. Click the arrow to display the list of camera views, and then click the camera view you 
want.



Lists the trucks competing in the race you're reviewing. You can view instant replay footage for any truck in 
the race. Click the arrow to display the list of participating trucks, and then click the one you want.



Click this to zoom in using the current camera view.



Click this to zoom out using the current camera view.



Click this to rotate the camera angle to the left horizontally.



Click this to rotate the camera angle to the right horizontally.



Click this to rotate the camera angle down along a 180-degree vertical axis.



Click this to rotate the camera angle up along a 180-degree vertical axis.



Click this to close the Instant Replay screen. If you want to keep the instant replay video, click Save before 
clicking Close.



Click this to save the instant replay as a file that you can share with other Monster Truck Madness players or 
simply view yourself again and again and again and….



Click this to open any previously saved instant replay file. Instant replay files have the file name extension .rpl,
(i.e., Snakewin.rpl).



Click this to jump to the beginning of the video.



Click this to play the video fast backwards.



Click this to play the video backwards at regular speed.



Click this to freeze the video.



Click this to play the video at regular speed.



Click this to play the video fast forward.



Click this to play the video in slow motion.



Click this to drive your truck with automatic transmission. Auto Shift lets you floor it without having to worry 
about shifting gears. However, automatic transmission diminishes your truck's get-up-and-go; if the 
competition uses manual transmission, they will have an acceleration advantage.



Click the arrow to display the list of driving cheats, and then click the one you want. 

· Auto Brake applies the brakes for you. 

· Auto Brake & Throttle accelerates your truck to its optimal speed and applies the brakes for you. 
However, you CANNOT go in reverse with this option selected.

When driving using manual transmission, Auto Brake & Throttle speeds your engine up to the maximum 
rpms for the gear you are currently in. You are still responsible for shifting up to the next higher gear.



When this check box is selected, the introductory movie plays when you start Monster Truck Madness.



When this check box is selected, Monster Truck Madness rewards your first place finish in a racing event by 
playing a victory video. Keep in mind that these videos are a reward for a well-run race. The only way to see 
them is to win!



When this check box is selected and you stop racing for a while, Monster Truck Madness displays a lively 
selection of race demos and video clips to tempt you back to the computer and back on the track!



Displays the number of opponents who are automatically added to the Competing Trucks list when you set up a 
race. Click the arrows to change the number of default opponents. You can have up to seven default opponents.



Click this to display Army Armstrong's helpful, wry commentary as text on the screen as you're racing. Among 
other things, Army alerts you when you've missed a checkpoint and when the first place finisher has crossed 
the finish line.



Click this to hear Army Armstrong's helpful, wry commentary through your computer's speakers or 
headphones as you're racing. Among other things, Army alerts you when you've missed a checkpoint and when 
the first place finisher has crossed the finish line.



Select this to display messages from your human opponents as you're racing in a multiplayer game. If you clear 
this check box, your opponents can fling all the insults they want at you; you'll never see them!



Specifies the number of seconds an opponent's message stays up during a multiplayer game. To change the 
length of time, click the box and then type in a new number.



Displays the Internet address (URL) of the Monster Truck Madness Web site. This is the Web site you go to 
when you click the Monster Truck Web Stop button on the game's opening screen. If the address changes, or 
you want to connect to a different Internet site, you can type the new address here.



Lists the resolution settings you can use for running Monster Truck Madness. Click the arrow to display all the 
resolution settings, and then click the one you want. Choose the resolution option that matches your processor 
(indicated in parentheses). When the Use Hardware Acceleration check box is selected, the resolution setting
it requires is automatically selected here.



This check box is automatically selected when Monster Truck Madness detects a hardware graphics 
accelerator card on your computer. If the card is detected, the simulation resolution is set to whatever 
setting the hardware accelerator requires. The check box is unavailable if an accelerator card is not detected. 
If the check box is dimmed and you have a graphics accelerator card, check with your card manufacturer to 
confirm that you have the latest driver installed.



This check box is automatically enabled when Monster Truck Madness detects a hardware graphics accelerator
card on your computer. Select this check box for smoother graphics, but a slower running game. Clear this 
check box for less smooth graphics, but a faster running game. (Bilinear filtering is used to achieve the 
smoothing effect.)



Click this to determine the appropriate graphics settings, which are based on where you've dragged the 
Graphics Quality Adjuster slider. When you select this check box, all the dimmed options are automatically 
set by the computer.



Drag the slider to a position that reflects the level of graphics quality you want for the game. Drag right to 
run the game faster but with less graphical detail. Drag left for the opposite effect. This option is only 
available when the Automatic Graphics Quality check box is selected.



Lists the image quality options you can choose for graphics display. Click Low if your highest priority is a fast-
running game. Click High for great image quality but a slower-running game.



Lists the texture options you can choose for graphics details. Texture affects the appearance of the trucks, 
signs, roads, surfaces, and terrain. Click Low if your highest priority is a fast-running game. Click High for 
smooth texture but a slower-running game.



Lists the shadow options you can choose from. Click None if you want the game to run faster and you don't 
care whether you can see the trucks' shadows. Click Complex to see detailed shadows of the trucks, trees, 
buildings, and other objects.



Lists the scenery detail options you can choose from. Click Sparse if you aren't worried about seeing the 
details of the buildings, bridges, trees, outhouses, garbage cans, road construction signs, etc. Click Complex if 
you really want to see the scenery details and encounter more obstacles as you dawdle down the road.



Lists the tire track options you can choose from. Click None if you want the game to run fast. Clicking Tracks 
Only or Track & Particles slows the game down, but you'll see tire tracks left by your competitors (which can 
show you the way to secret shortcuts!). If you really want to see the dirt (and water and mud) fly, click Tracks
& Particles.



Click this if you want to see clouds in the sky as you're driving. Clear this check box if you want the game to 
run faster.



Click this if you want to see a horizon line and mountains, trees, or other terrain in the distance as you're 
driving. Clear this check box if you want the game to run faster.



Click this to have Monster Truck Madness automatically switch to full-screen (in the simulation resolution you 
specified in the Simulation Resolution list) when you start a new race.



Click this to see your tires smoke when you peel out or burn rubber on a tough turn. Clear this check box if you
want the game to run faster.



Click this to display your truck's dashboard when you're driving in cockpit view. You can display the dashboard 
with or without the steering wheel. If you clear this check box, the Steering Wheel check box is unavailable.



Click this to display the steering wheel, which gives you visual feedback on your steering when you are driving 
in cockpit view. You can't display the steering wheel without the dashboard. If the Dashboard check box is 
cleared, the Steering Wheel check box is unavailable.



Lists the controls you can use when driving in Monster Truck Madness. Click the arrow to display the list of 
available driving controls, and then click the one you want.



Click this to calibrate your joystick, gamepad, or ThrustMaster T1 or T2 steering wheel, brake, and gas pedals.



Click this to open the Customize Joystick dialog box, where you can assign new game-related functions to the 
buttons and other controls on your joystick. You can also click this to open the dialog box where you can revert
to your joystick's original settings for Monster Truck Madness.



Click this to open the Customize Keyboard dialog box, where you can assign new game-related functions to 
keys on the keyboard. You can also click this to open the dialog box where you can revert to the keyboard's 
original settings for Monster Truck Madness.



Drag the slider to a location that reflects the degree of sensitivity and responsiveness you want from your 
selected driving control. Drag left for a more sensitive steering response, drag right for less.



Lists game controls and their assigned keyboard settings. To assign a different key to a game control, highlight
the control in the list, and then click Change.



Click this to open a dialog box, where you can assign a different key to the game control currently highlighted 
in the Keyboard Settings list.



Click this to revert to the original keyboard assignments for Monster Truck Madness game controls. Any 
changes you've made to keyboard control assignments are canceled.



Lists game controls and their assigned joystick settings. To assign a different joystick button or switch to a 
game control, highlight the control in the list, and then click Change.



Click this to open a dialog box, where you can assign a different game function to the joystick button or switch
currently highlighted in the Joystick Settings list.



Click this to revert to the original joystick control assignments for Monster Truck Madness game controls. Any
changes you've made to the joystick controls are canceled.



Lists the game controls you can assign to the joystick button, which is named on the left side of this list. Click 
the arrow to display the complete list of game functions you can assign to the button, and then click the 
function you want.



Click this if you are using a joystick with a throttle control, and wish to assign the acceleration function to 
that throttle control.



Lists the keys you can assign to the game function, which is named on the left side of this list. Click the arrow 
to display the complete list of keys you can assign game functions to, and then click the key you want.



Select this to hear sound effects, including crashes, splashes, brake screeches, and the roar of the crowd as 
you pass the grandstands. Clear this check box if you want the game to run faster. Sound effects are not the 
same as commentary: To turn off commentary, on the Options menu, click Game, and clear the Hear 
Commentary check box. Changes take effect after you click OK.



To increase the volume of sound effects, drag the slider to the right. To decrease the volume, drag it left. 
Changes take effect after you click OK.



Click this to hear music as you're racing. Changes take effect after you click OK.



Drag the slider to the right to increase the volume of game music, drag it left to decrease the volume. Changes
take effect after you click OK.



Click the arrow to display the list of playback formats, and then click the one you want. Click Mono to make the
game run faster. Changes take effect after you click OK.



Click this to open a dialog box, where you can remedy choppy, clipped, or delayed sound. Changes take effect 
after you click OK to close the Sound Options dialog box.



Click this to play music from the Monster Truck Madness CD-ROM or from a music CD that you've inserted in 
your CD-ROM drive.



Click this to play synthesized music tracks. With synthesized music, you don't need to have a disc in the CD-
ROM drive. Changes take effect after you click OK.



Click this to confirm that your CD-ROM drive is functioning properly. Follow the directions on the screen.



Displays the current number of buffers. If the sound is choppy or clipped, or if the sound effects are delayed,
click the arrow to increase the number of buffers slightly. Click Test to apply the new settings and hear the 
results. Experiment until the sound is smooth and timed appropriately.



Displays the current buffer size. Before changing the buffer size, first try increasing the number of buffers. 
Then, click Test. If the sound is still choppy, clipped, or delayed, click the arrow to increase the buffer size 
slightly.



Click this to test the changes you've made to the number of buffers and/or the buffer size. Experiment with 
the settings until the sound is smooth and timed appropriately.



Click this to revert to the original default buffer settings.



Lists all the tracks for the selected race event type. When the Tournament tab is selected, this lists all 
existing tournaments. Click the arrow to display the list of tracks or tournaments, and then click the one for 
which you want to see hall of fame results.



Click this to display the drag race hall of fame, where you can review the best times for each drag race track.



Click this to display the circuit race hall of fame, where you can review the best circuit race performances, 
including best average lap time and best lap time, for each circuit track.



Click this to display the rally race hall of fame, where you can review the best race performances for each 
rally track.



Click this to display the tournament hall of fame, where you can review the best race performances for each 
tournament, including tournaments you've created.



Click this to leave the hall of fame and return to the previous screen.



The Draw screen displays the match-ups and results for each heat. The two trucks due up next at the starting
line have the words "NEXT UP" flashing between them. The winner of each heat is always outlined in green.



Click this to skip viewing the drag race heat that is "NEXT UP." You can skip viewing only those heats in which 
your truck is not racing.



Click this to go to the Instant Replay screen, where you can review and save a video of your (and your 
opponent's) recent racing performance.



Click this to return to the race!



Click this to end the current race.



Click this to host the game session. As host, you pick who participates, the type of race, and the track.



Click this to join an existing game session. When you join, you establish a connection via a LAN (Local Area 
Network), modem, or the Internet, and then wait for a host to select you to join.



Type a brief description here that will entice potential opponents to join your game session. Potential 
opponents will be able to see and select this name from a list of available game sessions.



Click the appropriate connection type, one for which you have the appropriate LAN (Local Area Network), 
Internet, or modem connection. 

· For play over a LAN, click WinSock TCP Connection or WinSock IPX Connection.

· For one-to-one play via a modem connection, click Modem Connection. 

· For play via an Internet connection, click Internet (TCP/IP) Connection.



Lists all the available potential opponents who have chosen to join your game session. When racing over a LAN 
(Local Area Network) or the Internet, you can add up to seven opponents; when racing one-to-one via a modem,
you can pick one opponent. In general, the more trucks racing, the slower the game runs.



Lists the opponents you've selected to race against. 



Click this to add to the race the name that is highlighted in the Available Players list.



Click this to remove from your game session the player whose name is highlighted in the Participating Players 
list.



Lists all players who have clicked Race to indicate that they are ready to head to the starting line. If you're 
the host, you may have to wait a few minutes while your competitors finish fine-tuning their trucks.



The items listed are dependent on the type of connection you use: LAN (Local Area Network), modem, or 
Internet.

For step-by-step help on joining a game session, see the "Multiplayer Racing" section in the online help, 
Monster Manual.



This dialog box is displayed while the host of the game session is informed that you want to join the race. Once
the host has selected you as a participant, the Races screen is displayed, and you select which truck you want 
to take onto the track.



When this button lights up, the host is ready to race. Click this button to go to the screen where you    can 
preview the track your host has chosen; or, to go to the garage to adjust your tire tread cut, suspension, or 
transfer gear ratio settings before heading to the starting line.



Monster Truck Madness Credits
© Copyright 1996 Microsoft Corporation.    All rights reserved.

Microsoft, Monster Truck Madness, Windows, and Sidewinder 3D are either trademarks or registered 
trademarks in the United States and/other countries.

BIGFOOT © Copyright 19__ by BIGFOOT 4X4, Inc.    All rights reserved.

Monster Patrol Incorporated © Copyright 19__ by Monster Patrol Incorporated.    All rights reserved.

Monster Patrol is a registered trademark of Monster Patrol Incorporated.

Snake Bite © Copyright 19__ by BIGFOOT 4X4, Inc.    All rights reserved.

Grave Digger © Copyright 19__ by __.    All rights reserved.

Carolina Crusher © Copyright 1996 by Gary Porter, Carolina Crusher Racing. All rights reserved.

Bear Foot © Copyright 19__ by __.    All rights reserved.

Rampage © Copyright 19__ by __.    All rights reserved.

Giant Promotions © Copyright 19__ by Giant Promotions.    All rights reserved.

Thrustmaster T2 © Copyright 19__ by __.    All rights reserved.

Ford © Copyright 19__ by __.    All rights reserved.

Dodge © Copyright 19__ by __.    All rights reserved.

Penda © Copyright 19__ by __.    All rights reserved.

Power Wheels by Fisher Price © Copyright 19__ by __.    All rights reserved.

Firestone © Copyright 19__ by __.    All rights reserved.

Goodyear © Copyright 19__ by __.    All rights reserved.
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Drag Racing Tips
· Driving at the rookie level is specifically designed to introduce you to the unique physics model of a 5-ton 

monster truck. If you signed in as a rookie and you think your truck doesn't have enough get-up-and-go, 
try signing-in as an intermediate. Or, click Garage on the race event screen, and then drag the Transfer 
Gear slider to the left, toward More Top-End Speed. Experiment until you find the transfer gear setting 
that is most compatible with your driving style.

· If you need to access the menu bar while you are racing and it is not displayed, press F4 to display the 
menu bar.

· To switch to a wide-angle, panoramic view of any external game view, press MINUS SIGN (-) on the main 
keyboard. To turn off panoramic view, press EQUAL SIGN (=).

· If you're not comfortable approaching the starting line at first, press S to have your truck automatically 
staged.

· Drag racing is all about pure speed and adrenaline, but you also have to watch where you're going. You will 
be disqualified if you cross out of your lane or into your opponent's lane, or if you leave ahead of the green
light. If you're driving under the intermediate or professional level, you will also be disqualified if you 
don't stage within 30 seconds.

· The Tacoma Dome and the Trans World Dome tracks feature J-style drag race tracks. If you're new to 
drag racing, start with the simpler, straight tracks before you take on the more challenging J-style.

· For advanced tips on staging, see Shallow Versus Deep Staging.



Circuit Racing Tips
· Driving at the rookie level is specifically designed to introduce you to the unique physics model of a 5-ton 

monster truck. If you signed in as a rookie and you think your truck doesn't have enough get-up-and-go, 
try signing-in as an intermediate. Or, click Garage on the race event screen, and then drag the Transfer 
Gear slider to the left, toward More Top-End Speed. Experiment until you find the transfer gear setting 
that is most compatible with your driving style.

· If you need to access the menu bar while you are racing and it is not displayed, press F4 to display the 
menu bar.

· To switch to a wide-angle, panoramic view of any external game view, press MINUS SIGN (-) on the main 
keyboard. To turn off panoramic view, press EQUAL SIGN (=).

· You MUST pass through all of a circuit's checkpoints in order to finish the race legally. While you are 
driving, press F to display the handy directional finder, which points you to the next checkpoint.

· Once the first place finisher has crossed the finish line, all other trucks are on their last lap. Once you've 
crossed the finish line, your view switches to automatic race camera view, where you can relive a little of 
the thrill of your driving performance.

· If you stray from the track, you can call the helicopter to bring you back to the track. Press H, and the 
whirly bird will come in for the big ride!

· To familiarize yourself with a track, observe how the computer trucks take the turns and straightaways. 
While you are driving, press K to switch to another truck's point of view. To switch between racing views 
for the current truck, press V. To get back to the cab of your truck, press CTRL+1.

· To display an overlay map of the track, press TAB. Your truck is displayed as a yellow dot, and you can see 
where you are in relation to your opponents.

· To display the pit board, Press O. The pit board gives you details on your time, lap number, and position in 
the race.

· If you turn on race commentary, Army Armstrong will let you know when you've missed a checkpoint!

· Shortcuts are legal, as long as you hit all your checkpoints!

· Experiment with different race views. You may find you prefer chase near view to cockpit view. Press V to
switch between race views for the current truck.



Rally Racing Tips
· Driving at the rookie level is specifically designed to introduce you to the unique physics model of a 5-ton 

monster truck. If you signed in as a rookie and you think your truck doesn't have enough get-up-and-go, 
try signing-in as an intermediate. Or, click Garage on the race event screen, and then drag the Transfer 
Gear slider to the left, toward More Top-End Speed. Experiment until you find the transfer gear setting 
that is most compatible with your driving style.

· If you need to access the menu bar while you are racing and it is not displayed, press F4 to display the 
menu bar.

· To switch to a wide-angle, panoramic view of any external game view, press MINUS SIGN (-) on the main 
keyboard. To turn off panoramic view, press EQUAL SIGN (=).

· You MUST pass through all of a rally's checkpoints in order to finish the race legally. While you are 
driving, press F to display the handy directional finder, which points you to the next checkpoint.

· Once you've crossed the finish line, your view switches to automatic race camera view, where you can 
relive a little of the thrill of your driving performance. The race ends automatically three seconds after 
the last human-controlled truck crosses the finish line.

· If you stray from the track, you can call the rescue helicopter to bring you back to the track. Press H, and
the whirly bird will come in for the big ride!

· To familiarize yourself with a track, observe how the computer trucks take the turns and straightaways. 
While you are driving, press K to switch to another truck's point of view. To switch between racing views 
for the current truck, press V. To get back to the cab of your truck, press CTRL+1.

· To display an overlay map of the track, press TAB. Your truck is displayed as a yellow dot, and you can see 
where you are in relation to your opponents.

· To display the pit board, Press O. The pit board gives you details on your time and position in the race.

· If you turn on race commentary, Army Armstrong will let you know when you've missed a checkpoint!

· Shortcuts are legal, as long as you hit all your checkpoints!

· Experiment with different race views. You may find you prefer chase near view to cockpit view. Press V to
switch between race views for the current truck.



Tournament Racing Tips
· Driving at the rookie level is specifically designed to introduce you to the unique physics model of a 5-ton 

monster truck. If you signed in as a rookie and you think your truck doesn't have enough get-up-and-go, 
try signing-in as an intermediate. Or, click Garage on the race event screen, and then drag the Transfer 
Gear slider to the left, toward More Top-End Speed. Experiment until you find the transfer gear setting 
that is most compatible with your driving style.

· If you need to access the menu bar while you are racing and it is not displayed, press F4 to display the 
menu bar.

· To switch to a wide-angle, panoramic view of any external game view, press MINUS SIGN (-) on the main 
keyboard. To turn off panoramic view, press EQUAL SIGN (=).

· Look for tournaments that include your favorite racing events on your favorite tracks. You're more likely 
to excel (and accelerate!) on tracks you've driven often.

· The tournaments that come with Monster Truck Madness were especially designed by experts to challenge
your monster truck driving skills. The tournament descriptions can help you find the type of challenge 
you're looking for.

· If you love every race in a tournament except one, create your own custom tournament and delete the one 
track you always have trouble with.

{button ,AL(`CustomTourny;changetourny')} Related Topics



Custom Tournament Racing Tips
· If you love every race in a tournament except one, create your own custom tournament and delete the one 

track you always have trouble with.

· Create a custom tournament that tests and challenges all your driving skills, and then use it as a training 
device for new players.

· Check the Microsoft Monster Truck Web Stop for postings of custom tournaments created by Monster 
Truck Madness players from all over the world.

http://www.microsoft.com/games/monster/

{button ,AL(`CustomTourny;changetourny')} Related Topics



Staging Tips
Staging is one of the biggest challenges new monster truck drivers face. If you're not up to the challenge, use 
the automatic staging feature.

To stage automatically

Before your truck reaches the starting line, press S.
Your truck moves forward, stages legally, and comes to a halt. All you have to do now is watch for the 
green and go for the gusto!

To stage like a pro
NOTE: Use the christmas tree starting signal overlay in the upper left corner of your screen to get feedback 
as you are trying to stage.

1 First, get a good view of the staging lines and the track: Press V until you are in blimp view and can see the
staging lines in front of your truck. (You don't have to stage from blimp view, you can stage from any view.)

2 Crawl forward slowly to the nearest line, the prestaging line.

The orange prestage light, the light at the top if the christmas tree, illuminates.

3 Roll forward to the next line, the staging line.

The orange stage light, directly beneath the prestage light, lights up.

4 When the green light illuminates, give it the gas!



Setting Your Monitor to Display 256 Colors
Monster Truck Madness runs best when your monitor is set to display 256 colors. If you choose to leave your 
monitor set to higher color modes, it is very likely that Monster Truck Madness will not run satisfactorily. 
However, if you use a 3D hardware graphics accelerator, you may be able to get satisfactory performance in 
higher color modes.

NOTE: Your monitor and display adapter determine whether you can change your screen resolution.

IMPORTANT: Print this topic before starting the procedure. As you follow the steps below, a dialog box 
appears which may obscure this topic. Refer to the printed topic to finish the procedure.

To set your monitor to display 256 colors

1 Click  to display the Display Properties dialog box.

2 In the Color Palette list, click 256 Color.
3 Click OK.
IMPORTANT: You may be prompted to restart Windows 95 in order for the display setting change to take 
effect. Before you restart Windows 95, press ALT+TAB to return to Monster Truck Madness and quit the 
game.

NOTE: If you don't have the necessary 256-color driver, or if you aren't sure that your video card supports 
256 colors, contact your video card manufacturer.





BIGFOOT Merchandise: T-SHIRTS
T-Shirt Sizes and Prices:
Kids sizes 6/8, 10/12, 14/16 $12.95

Adult sizes M, L, XL $14.95

Adult size XXL $16.95

Item #1: Black T-shirt, 100 percent cotton, 1997 BIGFOOT & the St. Louis Arch

Item #2: White T-shirt, 100 percent cotton, UV-Ray design "See the colors appear in the sunlight!"



Item #3: Black T-shirt, 100 percent cotton, SNAKEBITE logo crest on front, large color design on back

For details on ordering, see BIGFOOT Merchandise Ordering Information.



BIGFOOT Merchandise: Embroidered Hats

All hats priced at $12.95
Item #4: Twill hat; Black/Royal or Gray/Royal; script design
Item #5: Twill hat; black/blue; burnout design
Item #6: Supplex hat; black or white; checkered flag logo
Item #7: Weathered denim hat; Team BIGFOOT logo
Item #8: Twill hat; black; SNAKEBITE logo
For details on ordering, see BIGFOOT Merchandise Ordering Information.



BIGFOOT Merchandise: Video, Folders, More!

Item # 9: '94/'95 Race Series, 30-minute video $10.95
Item #10: BIGFOOT Folder $1.95

Item #11: Action Album $3.95

Item #12: 1997 BIGFOOT Remote Control; body only $24.95
Includes decals (item not pictured)
For details on ordering, see BIGFOOT Merchandise Ordering Information.



BIGFOOT Merchandise: Ordering Information
ORDER BY MAIL, PHONE, OR FAX

BIGFOOT 4X4, Inc.
Attn: Dept. MS
6311 N. Lindbergh Blvd.
St. Louis, MO 63042
http://www.bigfoot4x4.com
Fax (314) 731-8114

Phone Orders Mon.-Fri. 9 AM to 5 PM CST (314) 731-8112 ext 118

Fax orders taken 24 hours a day (314) 731-8114

Voicemail orders taken 24 hours a day (314) 731-8112

Visa, MasterCard, Discover, check, or money orders accepted

All prices and items subject to change; we reserve the right to substitute.

BIGFOOT Merchandise Order Form

· Sorry, No COD's.

· Allow 4 to 6 weeks for delivery.

· Returned checks subject to $15.00 service charge.

Shipping and handling charges
$25.00 or less $3.95

$25.01-$50.00 $5.95

$50.01-$75.00 $7.95



$75.01-$100.00 $8.95

$100.00 or more $9.95 outside the U.S.

$100.00 or more FREE in the continental U.S. only



Microsoft SideWinder 3D Pro

Overview

Microsoft® SideWinder™ 3D Pro is an advanced game controller, incorporating Digital-Optical technology to 
provide more precise, more reliable, and more intense game play. Its advanced feature set includes 3D 
Rotation, bringing even more excitement and challenge to your games. 

Recommended for Ages: 10 and up.

Features



SideWinder 3D Pro has eight buttons: 
· Four conventional joystick buttons on the handle (buttons 1-4) 

· Four additional programmable buttons on the base (buttons 5-8) 

The Hat Switch
You have directional control with a touch of the thumb. For example, games often use the hat switch to change
point of view, modify ship direction, or change altitude.

The Slider
You have command over incremental game functions. For example, to adjust thrust, throttle, or altitude.

Joystick Rotation
With a flick of the wrist the SideWinder 3D Pro gives you an additional third degree of freedom. For example,
games often use joystick rotation to change point of view, move the rudder, aim weapons, or strafe to the side.

System Requirements
· 600 K

· MS-DOS, Microsoft Windows 3.1 or later, or Windows 95

· 15 pin Gameport

· To use the enclosed joystick driver for Windows 95, you also need: 

· A 3.5-inch high-density disk drive

· Windows 95 operating system

Pricing Information



Microsoft SideWinder 3D PRO (Digital Stick) v1.00 

(U.S. 326-095V100, GMP, 3.5, Price: $59.95)

Ordering Information
Windows®, MS-DOS® U.S.    326-095V100 $64.95

SideWinder 3D Pro/MechWarrior2 bundle Windows, MS-DOS U.S.    3261095v100 $94.95

Call 1-800-457-9530 to order direct or see your reseller. Customers who are deaf or hard of hearing can 
reach Microsoft's text telephone (TT/TDD) services at 1-800-892-5234. Retail prices may vary.



ThrustMaster Formula T2 Driving Controls

Experience the thrill of REAL racing action with the new Formula T2™    driving controls.
The Formula T2 driving controls feature a steering console with steering wheel, shifter, and two dash buttons. 
The console mounts easily, quickly, and secures on almost any desktop using our new dual clamping mechanism. 
The redesigned steering wheel remains 10" in diameter, but now fits comfortably in your hand with the one-
inch-thick foam rubber grip for greater control and less fatigue. Tensioned mechanics provide increased 
resistance the farther the wheel is turned. Total steering range is 260 degrees.
The gear change lever operates as a sequential shifter. Each press forward moves up through the gears, and 
each press back, down through the gears.

The two dash buttons can function as reverse or any other needed function if supported in the software 
simulation.

In addition to the steering console, the gas and brake unit is mounted on a sturdy metal base floor unit. Unlike 
its predecessor, the T2 pedals are actual pedals instead of roller wheels. The pedals provide greater control 
and are easier to keep your feet on.

The Formula T2 package includes both the steering console and floor unit.

Compatible with IBM and compatible PCs, the Formula T2 is constructed of ABS plastic, Delrin, and glass-filled
nylon. A speed adjustable game card, like the ThrustMaster ACM Game Card, is highly recommended.

Don't let your sense of realism stop with your choice of controllers. With the Formula T2, all you're missing is 
the smell of burning rubber and racing fuel.

The Thrustmaster Formula T2 steering wheel and pedals really enhance the Microsoft® Monster Truck 
Madness™    driving experience.    All you need is a truck cab in your living room and you're set!

Suggested (U.S.) Retail Price: $179.95 

Ordering Information
Call the ThrustMaster Order Department at (503) 615-3200, Monday-Friday, 8 AM-5 PM PST, to order direct 
or see your reseller. Or, send a fax to (503) 615-3300 Fax. Please have your name, shipping address, daytime 
phone number, and credit card number when you call. Retail prices may vary.

Copyright © 1995 ThrustMaster, Inc.
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Missing Table of Contents
Winhelp did not find the file MONSTER.CNT. This file may be missing or damaged.

Run setup again to restore this file.




